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Important
The following functions are for reference only. Some series products may not
support all the functions listed below.
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1 Network Config

1.1 Network Connection

Network camera and PC connection mainly has two ways, see Figure 1- 1 and Figure 1-2.

ar cable

IPC

Figure 1- 1

..--"""FF_-F

cable T~—_abie

__— switch or

router
‘3 ’
I

PC

Figure 1-2

Before you access network camera via the Internet, you need to have its IP address. User can use
Config Tool to search IP of the network camera. Please refer to Config Tool manual.

1.2 Login

It needs to install WEB plug-in when you use WEB client for the first time, the exact operation steps are

shown as follows:
Open IE and input network camera address in the address bar. (The factory default IP address is

192.168.1.108).
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After successful connection, the login interface is shown as in Figure 1-3; input your user name and
password. Default factory username is admin and password is admin.

Figure 1-3

The system will display “Update Password” prompt box for your first login, users need to modify the
password and save it properly.

First login, suggest updating password.

New Password l

Confirm Password

("] Don’'t show me again

Ok Cancel

Figure 1-4

After successful login, you may see the interface shown as in Figure 1-5.
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Figure 1-5

Click on “Please click here to download and install the plug-in”. The system pops up warning information
to ask you whether run or save this plug-in. See Figure 1-6.

Do you want to run or zave this file?

MHame: webplugin.exe
Type: application, 1.08ME

From: 10.10.4.198

Run JI Save ][ Cancel ]

While files fram the Intermmet can be useful, thizs file type can
potentially harm your computer. [F pou do not truzst the source, do not
run or gave this software. What's the rigk?

Figure 1-6
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You must either run or save the file to local and install it. Follow the following steps. Click on run, you
will see Figure 1-7and Figure 1-8.

Ready to Install
Setup is now ready to begin instaling webplugin.exe on your computer,

Click Install to continue with the installation.

Figure 1-7
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Installing
Flease wait while Setup installs webplugin,exe on your computer,

Registering files...

Figure 1-8
When plug-in installation completes, the installation page closes automatically. The web-end will refresh

automatically, and then you can view video captured by the camera.

| ainstream | sub sveam 1 supsteam2 RN TCE x| LR e N-dl= [HEH

& o 5 @E o 5 ©

Figure 1-9
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2 Live

After you logged in, you can see the live monitor window. See Figure 2-1.

Figure 2-1

There are four sections:

® Section 1: Encode setup bar

® Section 2: System menu

® Section 3: Window function option bar
® Section 4: Window adjust bar

2.1 Encode Setup

Note: Some series don’t support sub stream 2.
The encode setup interface is shown as in Figure 2-2.

Sub Stream 1 Sub Stream 2 Eeddtdesd m

Figure 2-2

Please refer to the following sheet for detailed information.
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Parameter Function

Click it to enable main stream video monitoring and click again
to disable it. Generally for storage and monitor.

Sub Stream 1 Click it to enable Sub Streaml video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

Sub Stream 2 Click it to enable Sub Stream 2 video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

You can select stream media protocol from the dropdown list.
There are three options: TCP/UDP/Multicast

Main stream

Protocol

2.2 System Menu

System menu is shown as in Figure 2-3.
Please refer to chapter 2 Live, chapter 3 PTZ, chapter 4 Playback, chapter 5 Setup, chapter 6 Alarm,
chapter 7 Log out for detailed information.

r Live T PTZ Fla:bank T S-EtUB T Alarm Luanut ]

Figure 2-3

2.3 Video Window Function Option

The interface is shown as below. See Figure 2-4.

Figure 2-4

Please refer to the following sheet for detailed information.

SN Parameter | Function
1 Relay-out It shows if there is any alarm output, status description is as
follows:

® Red: means there is alarm output.
® Grey: means alarm is over.
Click on the button to force alarm to be on or off.
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® When the video is in the original status, click it you can

2 Digital
Zo%m select any zone to zoom in. In the non-original status,
you can drag the zoom-in zone in specified range. Right
click mouse to restore previous status.
® Click it; you can use the middle button of the mouse to
zoom in/out the video size.
3 Snapshot Click on the button to snapshot, save picture to path in Ch
5.1.2.5.
4 Triple Click it to take snapshot upon the video at the frequency of
Snapshot one picture per second. All images are saved to path in Ch
5.1.2.5.
5 Record Click it to record the video. All videos are saved to path in
Chapter 5.1.2.5.
6 Easy focus | Click it, you can see there are two parameters on the preview
video: AF Peak and AF Max.
AF Peak: It is to display the video definition during the focus
process.
AF Max: It is the most suitable value for the video definition.
The close the AF Peak and AF Max is, the better the focus
effect is.
7 Audio Turn on or off audio when you are monitoring.
8 Talk Click it to start or end bidirectional talk.
9 Help Click it to open help file.

2.4 Video Window Setup

The interface is shown as in Figure 2-5.

2.4.1 Image Adjustment

7 —
& 100% 53 o it O

ONONONONORONONO)

Figure 2-5

See Figure 2-6 for image adjustment.
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Image Adjustment

Figure 2-6

Click this button to display/hide image control interface. Click it to open picture setup interface. This
interface is on the top right pane.

Please refer to the following sheet for detailed information.

Parameter Function

Video It is to adjust monitor video Note:

setup brightness. ® All the operations here apply
to WEB end only.

® Please go to Setup-

m It is to adjust monitor video

conrasiness. >Camera->Conditions to
a It is to adjust monitor video adjust corresponding items.
hue.

E It is to adjust monitor video
saturation.

Reset | Restore brightness,
contrastness saturation and
hue to system default setup.

2.4.2 Original Size
Click this button to go to original size. It is to display the actual size of the video stream. It depends on
the resolution of the bit stream.

2.4.3 Full Screen
Click it to go to full-screen mode. Double click the mouse or click the Esc button to exit the full screen.



Network Camera Web 3.0 Operation Manual

2.4.4 Width and Height Ratio
Click it to restore original ratio or suitable window.

2.4.5 Fluency Adjustment

There are three levels of fluency for you to select (Realtime, Normal, and Fluency). The default is
normal.

2.4.6 Rules Info

Click the button, preview image will display intelligent rules after enabling; it is “enable” by default.
2.4.7 Zoom and Focus
Click this button and the focus zooming interface appears on the right of preview interface, as shown in
Figure 2-7, click left mouse button to adjust focus zooming configuration.

Note:

» The product series which support motorized zoom, synchronous focus and back focus have this

button.

» Auto-focus after zoom and focus adjustment.

2.4.8 Fisheye/Trigger Track

Click the button, installation mode and display mode interface will show up on the right of the preview
interface, see Figure 2-8 and Figure 2-9, single click to switch different installation mode and display
mode, or different display modes, it is enabled by default.

Note:

It is only supported by some models.

Zoom and Focus

Zoom Speed Ej

Far

&+ Auto Focus
Restore All
Refresh

Regional Focus

Figure 2-7
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Parameter

Function

Adjust the focal length of the lens by clicking or long pressing “+"“-’buttons.

Zoom
Step length is used to adjust the length of one step with one click.
Focus Adjust the sharpness of the lens by clicking or long pressing“+”. “-” buttons.
Step length is used to adjust the length of one step with one click.
Click to adjust the image definition automatically.
Auto- )
Note:
focus
Other lens operations are not allowed during the process of auto-focus.
Reset the lens to zero position to eliminate the accumulative error of lens.
Reset All | N0 _ _ ) _
Please reset when the image adjustment is not clear or operating zoom focus many
times.
Refresh Synchronize the location of drag slider of lens and zoom focus after hardware zoom
focusing.
Regional | Click it and use the mouse to select a zone, then the device can auto focus within the
Focus specific region.

-
5

Installation Mode

In-ceiling Mount Wall Mount Ground Mount

Installation Mode Installation Mode

o . I
> 47 =
.

ad

Display Mode Display Mode
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Figure 2-8

parameter

Note

Installation Mode

Three modes which are ceiling mount, wall mount and ground mount.

Display Mode

It represents the display mode of the current image (default supports original
image mode), the display modes may be different according to different
installation modes. It is shown as follows:

e Ceiling: 1P+1. 2P, 1+2, 1+3. 1+4. 1P+6. 1+8.

e Wall: 1P, 1P+3. 1P+4. 1P+8,

e Ground: 1P+1. 2P. 1+3. 1+4. 1P+6. 1+8.

Note:

The default displays original image mode when switching installation mode.

In-ceiling/Wall/Ground

O

image

It menas the original image without de-warpping

Original

In-ceiling/Ground

360°expanded rectangular panorama + independent
sub image, the sub image and the subbox in the
— expanded rectangular panorama support zoom and
1P+1 movement, for the expanded rectangular panorama
also supports left and right starting point movement.

Two related 180° expanded rectangular pictures, two
subwindows form 360° panorama anytime, which is
also called “dual panorama”. Two expanded
op rectangular pictures both support left and right
movement starting point, which are also linked by
eachother.

il

Original image + 2 independent sub images, both the

sub image and the subbox in the original image

’%}—‘ support zoom and movement. The original image also

1+2 supports changing starting point by rotation (no such
display mode for ground installation).

O
]

Original image + 2 independent sub images, both the
sub image and the subbox in the original image
support zoom and movement. The original image also
supports changing starting point by rotation

Ol

Original image + 4 independent sub images, both the

= sub image and the subbox in the original image

1+4 support zoom and movement. The original image also

supports changing starting point by rotation
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parameter

Note

—1P+6

360°expanded rectangular panorama +6 independent
sub image, both the sub image and the subbox in the
expanded rectangular panorama support zoom and
movement, for the expanded rectangular panorama
also supports left and right starting point movement.

5]

1+8

Original image + 8 independent sub images, both the
sub image and the subbox in the original image
support zoom and movement. The original image also
supports changing starting point by rotation

Wall

1P

From left to right 180° expanded rectangular
panorama, which supports up and down movement
and changes vertical angle of view.

180° expanded rectangular panorama+3 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

1P+4

180° expanded rectangular panorama+4 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

Fﬁ
1P+8

180° expanded rectangular panorama+8 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

Display Mode

Al B3
.._..ll'

Figure 2-9

Enable the trigger track on the interface of tripwire or intrusion, and draw the rule of tripwire or intrusion,
the scene of trigger track window will change according to the moving object when it triggers rule alarm
until the moving object disappears from the view range of the camera. Please refer to “5.3.4 IVS” for
more details about the rules drawing and parameter config of tripwire and intrusion.

Trigger track includes three modes which are 1P, 1P+3 and 1P+5.
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° E 1P: Original picture

o .. 1P+3: Original picture and three trigger track windows, it can adjust the location and size of

three trigger track windows on the original picture.

|
X
o 1P+5: Original picture and five trigger track windows, it can adjust the location and size of

five trigger track windows on the original picture.
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3 PTZ Control

Here you can view direction keys, speed, zoom, focus, iris, preset, tour, scan, pattern, aux on, off and
PTZ setup button. See Figure 3-1.

Note:

Before PTZ operation, please make sure you have properly set PTZ protocol. (Please refer to Ch 5.5.3).
Currently only IPC-HFXXXX series and —PT series products can support PTZ function.

Parameter Note

® PTZ supports eight directions: left/right/up/down/upper left/upper
right/bottom left/bottom right.

It controls rotation speed. The longer the step length, the higher the speed.
Step length control PTZ, zoom, focus and iris.

Use mouse to draw a box in monitoring video, PTZ will rotate and focus to
Quick Position | uickly positioning.

PTZ direction

Speed

®
I T _ - Pre
" ose@0
000
Speed(1-8). EEl

Zoom

PTZ Settings
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000
0®o
00O

speed(1-5): [jE

© 0

© O
© -0

PTZ Settings

Figure 3-2
PTZ setting interface is shown as in Figure 3-3.
Here you can set scan, preset, tour, pattern, assistant function and light and wiper plus view coordinate.

PTZ Settings

Figure 3-3

3.1 Scan

Scan interface is shown in Figure 3-4.
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PTZ Settings

P Start W Stop

Set Left Set Right

Figure 3-4

Steps to scan are:

Set Left Set Right

Step 1. Click on Set button, display icon.

Step 2. Move via direction key to select left, click on Set Left to set left border of camera
Step 3. Move via direction key to select right, click on Set Right to set right border of camera.
Step 4. Complete scan path setup.

3.2 Preset

Preset interface is shown in Figure 3-5.
PTZ Settings

Preset

Figure 3-5

Steps to preset are:

Step 1. In preset box, input preset value.

Step 2. Click on Go to, camera rotates to preset position.

Step 3. Use direction key to rotate camera, and in preset box input preset value.
Step 4. Click on Add to add a preset. Range of preset relates to PTZ protocol.

3.3 Tour

Tour interface is shown in Figure 3-6.



Network Camera Web 3.0 Operation Manual

PTZ Settings

P Start W Stop

Figure 3-6

Steps to tour are:

Step 1. In tour box, input tour path value.

Step 2. Click on Add. Range of tour relates to PTZ protocol.

Step 3. In preset box, input preset value.

Step 4. Click on Add as to add a preset in this tour. If click on Del, it deletes this preset in tour.
Note:

You can add more than one preset here, or delete more than one preset.

3.4 Pattern

Pattern interface is shown in Figure 3-7.

PTZ Settings

5
EZIETR

Figure 3-7

Steps to set pattern are shown as follows:

Step 1

Input pattern serial number value in the box, click “Add” and it will display “Start Rec” and “Stop Rec”.
Step 2

Click “Start Rec” to implement a series of operations such as zoom, focus, iris, direction and so on.
Step 3

Click “Stop Rec” to complete the setting of a pattern path.

Step 4
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Click “Start” and it will start pattern according to the pattern spot which has been set; click “Stop”
and the pattern ends.

3.5 Assistant

Assistant interface is shown in Figure 3-8.

PTZ Settings

Assistant

Aux On Alx Off

Figure 3-8
Steps to assistant are:
Step 1. In assistant box input assistant value.
Step 2. Click on Aux On to turn on aux function.
Click on Aux off to turn off aux function.

3.6 Light Wiper
Light wiper interface is shown in Figure 3-9.

PTZ Settings

Light Wiper -

Enable Disable

Figure 3-9
Steps to light wiper are:
® Click on Enable to enable light wiper function.
® Click on Disable to disable light wiper function.
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4 Playback

Web client playback supports video playback and picture playback.

Note:

Before playback, user shall set storage management as in Ch. 5.4.

4.1 Playback

The playback interface is shown as in Figure 4-1.

-le o

Fio e
[S=EE= 0 SO Card [~}

1 00000 O

Stop Record Type All General Motion B Alarm Manual B

Figure 4-1

There are four sections:

Section 1: Function of play
Section 2: Playback file
Section 3: Play time cut
Section 4: Record type
Section 5: Progress bar
Section 6: Assistant function

18:00

< >
Sun Mon Tue Wed Thu Fri Sat

1
213456 7]8
QIO ji2p13|1415
16 17 18 19 20 21 22 AR
23 2425 26 27 28| 29

30 [[31]

m—=—
CIREEEEEET
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4.1.1 Function of Play
The function of play is shown as in Figure 4-2 and Figure 4-3.

00000 O =0

O @ 6@ @ 6 ® @ @-1

Figure 4-2

00000 O =0

© e 6 e 6 ® O &2

Figure 4-3
Parameter Function
@ Pla When you see this button, it means pause or not played record. Click on this
y button, switch to normal play status.
@ Stop Click this button to stop playing.
Click on this button to go to next frame.
(® Play by frame Note:
You shall pause record when you use this function.
@ Slow Click on this button to play slowly.
® Quick Click on this button to play quickly.
® Silent When this button displays, it means audio is silent. Click on this button to
switch back to normal.
@ Volume Click on left mouse to adjust volume.
-1 Fisheve Click this button and fisheye device can adjust display mode according to
y different installation mode during the process of playback.
Click the button and it will playback and display intelligent rules and object
-2 Rule Info detection box if the video is equipped with intelligent rule info after the
function is enabled, it is off by default.
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4.1.2 Playback File
In calendar, blue date represents data currently has video record or snapshot. See Figure 4-4.

Data Src  RIEEET) 7
< 2013 I8

Sun Mon Tue Wed Thu Fri Sat

Parameter Function
) e Select “dav”, as video playback.
File Type - .
e Select “jpg” as picture playback.
Data Source Default is SD card.

Step 1. Click on data in blue, time axis displays record file progress bar in color. While, green represents
normal record, yellow represents motion detect record, red represents alarm record, and blue
represents manual record.

Step 2. Click on certain time on progress bar, playback starts from this time. See Figure 4-5.

Figure 4-5

Step 3. Click on file list = , select date file will be displayed in list.

Step 4. Double click on file in list, playback this file and display file size, start time and end time.
See Figure 4-6..
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00 : 00 : 00 - 23 : 59 : 59 jfe}

Download Format @ dav © mp4

Start Time  File Type
154939 H ©
15:50:07
15:54:38
16:25:13
16:31:35
16:32:06
16:45:58
16:54:00

OCO0O00O0000

17:00:54

<171 » »i (IR D
Begin Time:
End Time:

File Size:

Parameter Function
BSearch It means records within searched start time and end time on the date.
Download

Format

There are two formats: dav, mp4.
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Parameter Function

m ® click the download button and download file to path in Ch. 5.1.2.5.
Download ® System does not support download and playback at the same time.

rs

Back Click on back button to go to calendar interface.

4.1.3 Playback Cut

Note:

Playback cut function will automatically pause playing record as playback cut and playback cannot be at
the same time.

Step 1. Click on start time to cut on time axis. This time must be within progress bar range.

—_—

Step 2. Move mouse to cut icon gﬁ . You will be ask to select start time. Click on cur icon 5‘5 as

finish cutting.

Step 3. Click on playback cut end time on time axis. This time must be within progress bar range.
— —

Step 4. Move mouse to cut icon-& you will be asked to select end time. Click on cut icon .& as

finish cutting.
Step 5. Click on Save button to save file cut to path in Ch 5.1.2.5. See Figure 4-7.

00:00:00-00:00:00 B

Figure 4-7

4.1.4 Record Type

After checking record file type, only selected file will be displayed in progress bar and file list. Users can
also select the record type to be displayed via the dropdown box which is above the file list. See Figure
4-8.

Record Type [ Al [ General [ Motion @ & Alarm & Manual W

Figure 4-8

4.1.5 Progress Bar
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O zhr O nr | O 30min

Figure 4-9
Parameter Function
O z4hr 24 hours Click on it, means video in past 24 hours.
©zhr |, hours Click on it, means video in past 2 hours.
Oinr |, hour Click on it, means video in past 1 hour.
®:z0min 30 min Click on it, means video in past 30 min.

4.1.6 Assistant Function
Video playback assistant function is shown in Figure 4-10.

Figure 4-10

Parameter Function

e Click on it, video in playback status if is in original size, user can
zoom in any area, If it is not in its original size, Right mouse click to
Digital Zoom restore its original size.

e Click on this button, you can scroll to zoom in.

E] Click on this button, you can snapshot video under playback status.
Snapshot Snapshot will be saved to path in Ch. 5.1.2.5.

4.2 Picture Playback

Web client picture playback interface has the following three functions:

Parameter Function

1 Play function bar

2 Playback file bar

3 Snapshot type bar
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See Figure 4-11.

Playback [ setup Alarm Logout

Data Src SD Card

e < NG

Sun Mon Tue Wed Thu Fri Sat

3|4]5

Snapshot Type Al [ Generalm E Sventm B Alam

Figure 4-11

4.2.1 Play

oo

Figure 4-12

Default icon is E and it means pause or not played picture. Click on play button to switch to

normal play status. lcon become m

Click on it to pause.
4.2.2 Playback File
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< 2013 [

Sun Mon Tue Wed Thu Fri Sat

Figure 4-13

Step 1. Click on file list = , select snapshot file of the date.

Step 2. Double click on file in list, to play this snapshot.

Parameter

Function

E Search

It means all snapshot files within the start time and end time of selected date.
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Parameter Function
E Click the download button to open snapshot file or directly download to local
Download according to the browser types.
L Back Click the back button to return to calendar interface and re-select time.

00 : 00 : 00 - 23 : 59 : 59 jfe}

Start Time  File Type
132316 H ©
13:24:55
13:25:09
13:25:19
13:25:29
13:25:40
13:25:50
13:26:09
13:26:19
13:27:41
13:27:51
13:28:01

®
(&)

o
V)
o
V)
o
o

= O
V)
o
V)

am

M <€41/1p Pl

Figure 4-14

4.2.3 Snapshot Type
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After checking snapshot file type, in file list only display file of selected type. Users can also select
the snapshot type to be displayed via the dropdown box above the file list. See Figure 4-15.

Snapshot Type All General Event l Alarm

Figure 4-15



Network Camera Web 3.0 Operation Manual

5 Setup

Web client setup support camera, network, time, storage, system and system info view.

5.1 Camera

The camera setting includes conditions, profile management, zoom and focus.

5.1.1 Conditions

Note:

The camera parameter may be different according to different models, please refer to the actual product
for more details.

5.1.1.1 Picture

Note:

The device which supports true WDR fails to support long exposure when true WDR is enabled.

Step 1

Select “Setup > Camera > Conditions > Picture” and the system will display the “Picture” image which is
shown in Figure 5-1.

Conditions

Profi Day [+
> Video
> Audio ] Stvle | Standard [=]
Network = e 5 —_— Y EIRLSlG Brightness [=] D 50
Event , — - EBaAR Contrast (=] D 50
Storage b " Ui Saturation (=] 8 50
system - : + Day &Night Sharpness (=] {0 50
Information » IR Light Gamma (=] D 50
Mirror ©) ON @ OFF
Flip | 0° E
Default H Refresh H Save
Figure 5-1

Step 2
Set picture parameters; please refer to the following sheet for more details about parameter setting.

Parameter Note

Style It is to set the picture style, which includes standard, soft and vivid.




Parameter
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Note

Brightness

It is to adjust the image overall brightness via linear adjustment mode.
The larger the number is, the brighter the picture is, and on the contrary it
is opposite. The picture get blurry easily when the value is set too big.

Contrast

It is to adjust the picture contrast. The bigger the value is, the bigger the
bright contrast becomes, and on the contrary it is smaller. The dark area
becomes darker and the bright area becomes overexposed easily when
the value is set too big. The picture becomes blurry when the value is set
too small.

Saturation

It is to adjust the color darkness and lightness. The color becomes darker
when the value is bigger; on the contrary it becomes lighter. The value
causes no influence to the overall brightness of the image.

Sharpness

It is to adjust the sharpness level of the picture edge. The bigger the
sharpness value is, the more obvious the image edge becomes, the image
is likely to generate noise more easily when the value is set too big.

Gamma

It is to change image brightness and improve the dynamic display range of
the image via nonlinear adjustment mode. The bigger the value is, the
brighter the picture becomes, and on the contrary it is opposite.

Mirror

After mirror is enabled, the monitoring image will be displayed invertedly.

Flip

It is to change the display direction of the monitoring image.
It includes following options:
e Normal: The monitoring picture is normally displayed.

e Flip mode 1. The monitoring picture is displayed with clockwise
rotation 90°

e Flip mode 2: The monitoring picture is displayed with anticlockwise
rotation 90°

e 180° : The monitoring picture is displayed upside down.
Note:

Please set the video resolution as 1080P or lower when applying flip mode
for some devices.

EIS

It can realize electronic anti-flicker function via comparison algorithm of
image difference, which can effectively solve the problem of image jittering
during application and it can make the image clearer.

Step 3

Click “save” and complete the image parameter config of the camera.




5.1.1.2 Exposure
Step 1

Select “Setup > Camera > Conditions > Exposure”. The system will display the “Exposure”
interface which is shown in Figure 5-2.

& | & Profile. Normal
> | 8 A s
> Audio R Anti-flicker  Qutdoor |z|
Network Mode | Auto [=]
Event » Backlight Aulofis @ ON ) OFF
Storage | rWB
A 3DNR @ ON (O OFF
System » Day & Night
: A Grade [=]* D 50
Information + IR Light

Step 2

It is to set the exposure parameter, please refer to the following sheet for more details.
Parameter Note

® You can switch to exposure mode when it is in outdoor

mode, it can realize the result in the corresponding exposure
mode.

® 50Hz: When the current is 50Hz, system can auto adjust the

exposure according to the environment brightness in case
there is any stripe.

Anti-flicker

® 60Hz: When the current is 60Hz, system can auto adjust the

exposure according to the environment brightness in case
there is any stripe.




Parameter

Note

Mode

It is the camera exposure mode.
Note:

® When “Anti-flicker” is “Outdor”, the “exposure mode” can be
set as “gain priority” or “shutter priority” mode.

® Different devices have different exposure modes; please
refer to the actual interface.

It includes the following options:

® Auto: It can auto adjust the image brightness according to
the environment.

® Gain priority: The device can auto adjust according to the
gain range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the gain value has reached to upper limit
or lower limit, which is to make the image reach the best
brightness.

® Shutter priority: The device can auto adjust according to the
shutter range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the shutter value has reached to upper
limit or lower limit, which is to make the image reach the best
brightness.

® Iris priority: Iris value is fixed, the device can auto adjust the
shutter value if the image brightness fails to reach effect and
the shutter value has reached the upper limit or lower limit,
the device can auto adjust the gain value to make the image
reach the best brightness.

® Manual: It is to manually set gain value and shutter value,
adjust the the displayed brightness of the image.

Auto Iris

It can set the parameter when the camera installs auto iris.

® The lens iris can auto adjust the size according to the
environment after auto iris is enabled, then the image
brightness will change accordingly.

® The iris value reaches the max when disabling auto iris, the
lens iris will not change according to the environment
brightness.

3D NR

It is to process the image with multiframe (at least two frames), it
can realize noise reduction of the image by using the interframe
information between the previous and latter frame.

Grade

It can set the parameter when “3D NR” is enabled.
The bigger the grade is, the better NR effect it can realize.




Step 3
Click “Save” to complete the parameter config of camera exposure.

5.1.1.3 Backlight

Backlight mode can be divided into BLC, WDR and HLS.

BLC: it can avoid cucoloris phenomenon of the darker area in the backlight environment.

WDR: It can suppress the overbright area and compensate darker area by enabling WDR, which can
make the overall image clear.

HLC: It is to weaken the high light, which can be applied in the areas such as toll gate, entrance and exit
of the parking lot and etc. As for extreme light, it can snapshot the human face in the dark environment
and it can realize better effect for the details of the plate number.

Step 1
Select “Setup > Camera > Condition > Backlight”, the system will display the interface of “Backlight”
which is shown in Figure 5-3.

" Profile | Normal
> Video
> Audio ] Rt Mode | OFF [=]

Network e e e . — — 4 » Exposure

Event ——— » Backlight

Storage B W

System » Day & Night

Information » IR Light

Figure 5-3
Step 2
Set the backlight parameter.
® \When the “Mode” is set as “Scene Self-adaptation”, the system will auto adjust the image
brightness according to the environmental brightness, which is to make the object display clearly in
the scene.
® \When the “Mode” is set as “BLC”, it can select default mode or customized mode.
€ When selecting “Default” mode, the system can realize auto exposure according to the
environment, which is to make the image in the darkest area clear to be seen.



€ When selecting “Customized” mode, the system can realize exposure upon the selected area
after it set customized area, which is to make the image of the selected area reach
appropriate brightness.
® \When the “Mode” is set as “WDR?”, it will lower the brightness of the area with high brightness and
enhance the brightness of the area with low brightness, which is to make the objects in both high
brightness and low brightness area display clearly.
Note:
There may be video loss of a few seconds when the camera is switched from non WDR mode to WDR
mode.
® When the “Mode” is set as “HLC”, the system will constrain the brightness of the area with high
brightness and decrease the size of the halo area, which is to lower the brightness of the whole
image.
Step 3
Click “Save” to complete the config of the backlight mode.

5.1.1.4 WB

WB is used to restore the white object in the scene by the camera, after WB mode is set, it can make
the white object look white in different environments.

Step 1

Select “Setup > Camera > Conditions > WB”, the system will display the interface of “WB”, which is
shown in Figure 5-4.

Conditions

> Video
> Audio 5 = t Fuchan Mode | Auto E
Network B S : e » Exposure
Event e : — » Backlight

System £ » Day & Night

Profile. Normal E

_ P
Information § » IR Light

| Default ‘ ‘ Refresh ‘ ‘ Save ‘

Figure 5-4
Step 2
Set WB mode.



® \When the “Mode” is set as “Auto”, the system can auto compensate white balance upon different
color temperatures, which is to make the image color normal.

® \When the “Mode” is set as “Natural”, the system can auto compensate white balance to the scene
without artificial light, which is to make the image color normal.

® \When the “Mode” is set as “Street Lamp”, the system can auto compensate white balance to the
outdoor scene at night, which is to make the image color normal.

® When the “Mode” is set as “Outdoor”, the system can auto compensate white balance to the most
outdoor scenes with natural light and artificial light, which is to make the image color normal.

® \When the “Mode” is set as “Manual’, it can manually set the value of red gain and blue gain; the
system can compensate the different color temperatures in the environment according to the
settings.

® \When the “Mode” is set as “Regional Custom”, it is to set customized area, the system can
compensate white balance to different color temperature of the images in the area, which is to
make the image color normal.

Step 3
Click “Save” to complete the config of WB mode.

5.1.1.5 Day & Night

It is to set the switch between color mode and black & white mode.

Step 1

Select “Setup > Camera > Conditions > Day & Night” and the system will display the interface of “Day &
Night”, which is shown in Figure 5-5.

Profile MNormal
>

> Audio o » Facugs Mode | Auto

— — - 1

Network e - QIR ——  Bxposure Sensitivity | Middle [+]
Event ~ B Hackiaft Delay|6S [=]
Storage 3 1 - » WB

System

» Day & Night

» IR Light

Information

| Default || Refresh || Save |

Figure 5-5



Step 2

Set day & night parameter; please refer to the following sheet for more details.

Parameter Note
It is to set the camera image displayed as color or black & white mode.
Note:
The setting of “Day/Night Mode” is not affected by the setting of “Profile
Management”.
Mode It includes the following options:
® Color: The camera image is displayed as color image.
® Auto: The camera can auto select color image or black & white image
to be displayed according to the environmental brightness.
® Black & white: The camera image is displayed as black & white image.
The parameter can be set when the “Day/Night Mode” is “Auto” .
Sensitivity It is to set the sensitivity of the switch between image color display and
black & white display.
The parameter can be set when the “Day/Night Mode” is “Auto” .
Delay It is to set the switch delay between image color display and white & black
display. The smaller the delay is, the faster of the switch becomes between
color display and black & white display.
Step 3

Click “Save” to complete the config of day/night mode.

5.1.1.6 Defog

The image quality will become weak when the device is in the environment with fog or haze, you can
enable defog function to adjust the image definition.

Step 1

Select “Setup > Camera > Conditions > Defog” and the system will display the interface of “Defog”
which is shown in Figure 5-6.




. Profile Day
> Video

S Aidio . R ke Mode | OFF [=]
Network e i J - + Exposure

Event e » Backlight

Storage : ] » WB

System » Day & Night

Figure 5-6
Step 2
It is to set defog mode according to the actual scene.
® \When the “Mode” is set as “Manual’, it is to manually set intensity and air light mode, the system
will adjust the image definition according to the intensity and air light mode which have been set
previously. As for air light mode, you can set manual or auto.

® \When the “Mode” is set as “Auto”, the system will auto adjust the image definition according to the
actual scene.

® \When the “Mode” is set as “Off”, then the defog function is disabled.

Step 3
Click “Save” to complete the config of defog mode.

5.1.1.7 IR Light

You can directly set the mode of IR light if the device is equipped with IR light.

Step 1

Select “Setup > Camera > Conditions > IR Light” and the system will display the interface of “IR Light”
which is shown in Figure 5-7.
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i " » Piclure Mode  SmartiR E
Network e e = s » Exposure

Event - g ~ » Backlight
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Storage i ' WB

System » Day & Night
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Information y » IR Light
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.

‘ Default H Refresh H Save ‘

Figure 5-7
Step 2
Itis to set IR light mode according to the actual scene.
® \When the “Mode” is set as “Manual’, it can manually set the brightness of IR light; the system will
realize light compensation to the image according to the IR light intensity.
® \When the “Mode” is set as “Smart IR”, the system can adjust the light brightness according to the
actual scene.
® \When the “Mode” is set as “Zoomprio”, the system can auto adjust the IR light according to the
brightness change of the actual scene.
€ The system will enable near light by priority when the actual scene becomes dark, the system
will enable the far light when the near light fails to meet the requirement of scene brightness
even if it is adjusted to the brightest.
€ The system will adjust far light brightness by priority to off and then adjust the brightness of
near light when the actual scene becomes bright. The system will always disable far light
when the focal length of the lens is adjusted to a certain wide angle, which is to avoid near
overexposure. Meanwhile, it can manually set light compensation to slightly adjust the
brightness of IR light.
® \When the “mode” is set as “Off”, it will not enable the IR light.

Step 3
Click “Save” and complete the config of IR light.



5.1.1.8 Profile Management

Step 1

Select “Setup > Camera > Conditions > Profile Management” and the system will display the interface
of “Profile Management”.

Step 2

Set profile management.

® \When the “Profile Management” is set as “Normal”, the system will monitor according to the normal
config.

Camera Conditions Profile Management Zoom and Focus

Profile Management € Normal {~ Full Time ¢ Schedule

> Audio Default ‘ | Refresh | | Save
Network

Event
Storage
System
Information

Figure 5-8
® \When the “Profile Management” is set as “Full Time”, you can select “Always Enable” in “Day” or
“Night’, the system will monitor according to the config of “always enable”.

Camera Conditions Profile Management Zoom and Focus

| Profile Management ¢ Normal & Full Time ¢ Schedule

Always Enable Day =

2o

> Audio

Network | Default ‘ | Refresh ‘ | Save

Event
Storage
System
Information

Figure 5-9
® \When the “Profile Management” is set as “Schedule”, you can set some period as day and another
period as night, for example, if it sets 0:00~12:00 as day, 12:00~24:00 as night, then the system will
monitor by adopting corresponding config in different periods.
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Figure 5-10
Step 3
Click “Save” to complete the settings of profile management.
Note:

Click “Default” to restore the device to default config; click “Refresh” to check the latest config file of the
device.

5.1.1.9 Zoom and Focus

Note:

Only motorized vari-focal devices support focus and zoom function.

Step 1

Select “Setup > Camera > Conditions > Zoom and Focus” and the system will display the interface of
“Zoom and Focus” which is shown in Figure 5-11.

Camera Conditions

Profile Management

> Video

> Audio
Network
Event
Storage
System

Information

zoom WDE (=) [ TELE Speed |20 - Restare Al

Focus NEAR (=) [ FAR  Speed [20 x| | [#lAutoFocus Refresh

Figure 5-11



Step 2

Adjust the focal length of the lens.

After it is zoomed, set “Speed” and press “+”, “-“or drag the sliding block directly to adjust.

Step 3

Adjust the lens definition.

After it is focused, set “Speed” and press “+”, “-“or drag the sliding block directly to adjust.

Note:

® Speed is used to set the length by pressing “+” and “-“.

® After adjusting the focal length of the lens or click “Auto Focus”, the device will auto adjust the
image definition, it is not allowed to implement other lens operation during auto focus.

® After several times of zoom and focus, the image fails to be adjusted clear, click “Restore All’ to
reset the lens to zero and remove the accumulative error of the lens.

® Click “Refresh” and the device will automatically synchronize the hardware to the location of sliding
block of lens zoom and focus.

5.1.2 Video

5.1.2.1 Video

Step 1

Select “Setup > Camera > Video > Video” and the system will display the interface of “Video” which is
shown in Figure 5-12 or Figure 5-13.

Camera Video Snapshot Overlay

> Conditions

Network Enable Sub Stream 2 v
Event Encode Mode H.264H v Encode Mode H 264H v
Storage Smart Codec OFF v * Resolution D1 (704*480) v
System Resolution 2304x1296 (230471296 ¥ Video Clip
TR S Frame rate(FPS) 30 v Framerate(FPS) |6 v
Bit Rate Type CBR v Bit Rate Type CBR v
Reference Bit Rate  1792-10240Kb/S Reference Bit Rate  48-886Kb/S
Bit Rate 6144 v Bit Rate 896 v
| Frame Interval 60 (30~150) | Frame Interval 12 (6~150)

#| Watermark Settings

Watermark Character | Digital CCTV

Default || Refresh ‘ ‘ Save

Figure 5-12 (Non fisheye)



Video

Snapshot

& Installation Mode Ceiling E
Record Mode 2P [=]
> Audio
Network Main Stream Sub Stream
Event [¥] Enable Sub Stream 1 [+]
Storage Code-Stream Type  General [+] Code-Stream Type | General [+]
System Encode Mode H.264 [=] Ehcauepde H 264 3
Information o 243242430 (2432,2432)5 Resolution G40x540_(640*540) E
Frame rale(FPS) 15 [~] bramesalelEESIRNY 15 [=]
Bit Rate Type CBR = Bit Rate Type CBR [~]
Reference BitRate  2048-11008Kb/S Reiessaca EitE e S22 R DG
BitRate 5192 [~] PR 1024 [=]
| Frame Interval 30 (15~150) | Frame Interval 30 (15~150)
sve 1(off) [~ sve {off) [=]
[¥] Watermark Settings
Watermark Character DigitalCCTV
Default ‘ ‘ Refresh | | Save

Step 2

Figure 5-13 (Fisheye)

Set video bit stream, please refer to the following sheet for more details about the parameters.

Parameter

Function

Installation Mode

It will display the parameter when the device is fisheye.
There are three installation modes for fisheye which are
ceiling, wall mount and ground installation, please
select installation mode according to the actual
installation scene of the fisheye.

The system will begin to switch after switching
installation mode, it will prompt successfully saved after
it is switched successfully.

Note:

The device end will output the dewarped video stream
after configuring installation and record mode, when the
device is accessed to third-party platform, it will directly
display the dewarped image on the third-party platform.




Parameter

Function

Record Mode

It will display the parameter when the device is fisheye.

The system will begin to switch after record mode is

switched, it will prompt saved successfully after it is

switched successfully.

The record mode will change according to the different

installation modes.

® 10: the original picture which is not dewarped.

® 1P:360° rectangular panorama.

® 2P: The mode can be set when the “Installation
Mode” is set as “Ceiling” or “Ground”. It is the 2
related 180° rectangular image, the two
subwindows can both form 360° panorama
anytime.

® 10+3R: original image + 3 independent sub
images, both the sub image and sub boxes in the
original image can support zoom and movement.

® 1R: Original image + independent sub image, the
sub boxes of the original image support zoom and
movement.

® 4R: original image + 4 independent sub images,
both the sub image and sub boxes in the original
image support zoom and movement.

® 2R: Original image + 2 independent sub images,
the sub boxes of the original image can support
zoom and movement, the sub image supports up
and down movement, which can change the
vertical angle of view.

Note:

The device end will output dewarped video stream after

configuring installation and record mode, when the

device is accessed to the third-party platform, it will

directly display the dewarped image on the third-party

platform.

Sub Stream Enable

Select “Enable” to enable sub stream.
The device supports enabling sub stream 1 and sub
stream 2 at the same time.

Smart Codec

It can enhance image compression performance and
reduce storage space by enabling intelligent encoding.
Note:

After intelligent encoding is enabled, the device will not
support third stream, ROI or intelligent event detection,
please refer to the actual interface for more details.




Parameter

Function

Encode mode

There are five options: H.264 (main profile standard,

H.264H (high profile standard), H.264B (Baseline

Profile), H.265 (main profile standard) and MJPEG

encode.

® The H.264, H.264H both are H264 bit stream.
H.264 is the Main Profile encode and you need to
enable the sub stream function in your camera and
set the resolution as CIF. Then you can monitor via
the Blackberry cell phone.

® The H.265 is the main profile encode mode.

® MJIPEG: In this encode mode, the video needs to
large bit stream to guarantee the video definition.
You can use the max bit stream value in the
recommend bit to get the better video output effect.

Resolution

There are multiple resolutions. You can select from the
dropdown list.

For each resolution, the recommended bit stream value
is different.

Note: When video is under rotating status, you cannot
set resolution higher than 1080P (excluding 1080P).

Video Clip

The function is only supported by sub stream 2, please
refer to “Video Clip” for more details below the sheet.

Frame Rate (FPS)

PAL: 1~25f/s, 1-50f/s NTSC: 1~30f/s or 1~60f/s.
The frame rate may vary due to different resolutions.

Bit Rate Type

There are two options: VBR and CBR.
Please note, you can set video quality in VBR mode.
Under MJPEG mode, only CBR is available.

Recommended Bit

Recommended bit rate value according to the resolution
and frame rate you have set.

® In CBR, the bit rate here is the max value. In

Bit Rate o
dynamic video, system needs to low frame rate or
video quality to guarantee the value.
® The value is null in VBR mode.
® Please refer to recommend bit rate for the detailed
information.

SvC Frame rate can be encoded by layer. It is a flexible
encoding method. By default, itis 1 as 1 layer. You also
can set 2/3/4 layers.

| Frame Here you can set the P frame amount between two |

frames. The value ranges from 1 to 150. Default value
is 50.

Recommended value is frame rate *2.




Parameter

Function

Watermark Settings

Select “Watermark Setting” and enable watermark
function. After the watermark function is enabled, you
can check if the video is tampered via verifying
watermark character.

Watermark Character

It is the character of watermark verification, it is
DigitalCCTV by default.

® Video Clip

1. Select “Sub Stream 2” in the drop-down box, click “Enable”.

. . Xl
2. Enable “Video Clip”, click >~ .

The system will display the interface of “Area”, which is shown in Figure 5-14.

Area

Resolution D1 (704*480) B Save Cancel

Figure 5-14




3. Select the needed resolution and clip the needed image on the interface, which is shown in Figure

5-15.
4. Click “Save”. You can check the clipped video in the preview interface (the sub stream 2 preview
interface only displays the clipped area), which is shown in Figure 5-15.

Figure 5-15

Step 3
Click “Save” to complete video stream setup.

5.1.2.2 Snapshot
The snapshot interface is shown as in Figure 5-16.

Video Snapshot

> Conditions
> Audio
Network
Event

Snapshot Type |Genera| '|

Image Size 1080P {1920°1080)
Quality 5

Interval | 13 A |

Storage | Default ‘ | Refresh | ‘ Save

System

Information

Figure 5-16



Please refer to the following sheet for detailed information.

Parameter Function

Snapshot type There are two modes: general (schedule) and Event (activation).
Image size It is the same as the resolution of main stream.

Quality It is to set the image quality. There are six levels.

Interval It is to set snapshot frequency. Optionall~7s/picture, customized.

5.1.2.3 Video Overlay
The video overlay interface is shown as in Figure 5-17.

Snapshot

> Conditions
> Audio
Network

Event

(O EUNEESN] () Enable @ Disable

» Channel Title
v Time Title

» Text Overlay
Storage + Picture Overlay
System » Counting

Information

‘_RemaveAll || Delete |(orRightcick)

‘ Defauit H Refresh || Save

Figure 5-17



Snapshot

> Conditions

» Privacy Masking @ Enable (O Disable

| | : : » Channel Titie Input channel titie:
> Audio

Network + Time Title l1IPC
Event " » Text Overlay

Storage ’ » Picture Overlay
System » Counting

Information

Figure 5-18

Path

Snapshot Overlay

> Conditions

> Audio

» Privacy Masking ¢ Enable Disable

» Channel Title |_| Week Display

Network

Event » Text Overlay

Storage b+ Picture Overlay
System » Counting

Information

Default ‘ | Refresh | | Save

Figure 5-19



> Conditions

@ Disable

» Privacy Masking (0 Enable

> »‘Qudm + Channel Titls Input Text:

Network v Time Title

Event » Text Overlay

Storage y S+ Picture Overlay

System ’ » Counting

Information
Text Align
Right

> Conditions

) Enable

» Privacy Masking @ Disable

» Channel Title Picture Preview:
> Audio
» Time Title
Network
3 e Text Overl.
Event - 5 & » Te ay
System » Counting

Information

Uplead Picture

Requirement for picture upload
1. Max size is 16k

2. Max resolution is 128x128 pixels.
3. 256 colors, bmp format.

Figure 5-21



Snapshot
> Conditions

> Audio

» Privacy Masking (0 Enable @ Disable
|+ Channel Title Statistics Type

) Tme e [¥] Enter Number

Network o
3 T, [¥] Leave Number
Event

i Text Ali
Storage » Picture Overlay ign

5 : i Left

Information

Figure 5-22
Please refer to the following sheet for detailed information.
Parameter Function
Privacy Masking ® Here you can privacy mask the specified video in the

monitor video.

® System max supports 4 privacy mask zones.

Time Title ® You can enable this function so that system overlays time
information in video window.

® You can use the mouse to drag the time tile position.

Channel Title ® You can enable this function so that system overlays
channel information in video window.

® You can use the mouse to drag the channel tile position.

® You can enable this function to overlay text in video
window.

® Private protocol is connected to mobile NVR, support GPS
information overlay.

® You can use the mouse to drag location box to adjust its
position. Alignment include align left and align right.

® You can enable this function to display overlay picture.
Click on disable to turn it off.

® Click on Upload Picture to overlay local picture into
monitoring window. You can drag the yellow box to move
it.

Note:

You cannot enable text and picture overlay at the same time.

Text Overlay

Picture Overlay




Counting ® Check “Enable” to display the counting statistics data in
the video monitoring window; check “Disable” not to
display.

® There are enter number and leave number for statistics
type and left align and right align for OSD info.

® Set privacy mask, channel title, time title, location, overlay

Refresh .
and save the change. You can click on Refresh to see
effect.
Default ® Click it to restore default config.
Save ® Click it to complete video settings.
5.1.2.4 ROI

Note: Some series don’t support ROI setup function.

Snapshot

Enable ® Disable

>A:dic; i Image Quality | G(best) ¥

Network
Event
Storage
System
Information

| Removs Al H Delete ‘ (Or Rightelick }

| Default H Refresh H Save

Figure 5-23



L uve | rr [ Pworec [ sewe | aam | Logout

Camera Snapshot Overlay

> Conditions

> Audio
Network

Enable ® Disable

Image Quality |G(best) ¥

Event
Storage
System

Information

Remove All Delete {Or Rightclick y

| Default H Refresh H Save

Figure 5-24
Parameters | Note
Enable Check “Enable”, then it will display the ROI in the video monitoring window;
Check “Disable”, then it won’t display.
e Set the image quality of ROI, ranging from 1~6, default is 6.
Image Note:
Quality For fisheye device, it ranges from 1~6 (best), default is 6 (best)
e Able to set area block, max 4 areas.
5.1.2.5 Path

The storage path interface is shown as in Figure 5-25.

Here you can set snap image saved path and the record storage path.

® The default monitor image path is C:\Users\admin\WebDownload\LiveSnapshot.

® The default monitor record path is C:\Users\admin\WebDownload\LiveRecord.

® The default playback snapshot path is C:\Users\admin\WebDownload\PlaybackSnapshot.
The default playback download path is C:\Users\admin\WebDownload\PlaybackRecord.

The default playback cut path is: C:\Users\admin\WebDownload\VideoClips.

Note:

Admin is locally logged in PC account.

Please click the Save button to save current setup.



Video Snapshot

> Conditions

> Audio

Live Snapshot C\Users\admin\WebDownload\LiveSnapshot Browse...

Live Record C\Users\admin\WebDownload\LiveRecord Browse...

Playback Snapshot  C:\Users\admin\WebDownload\PlaybackSnapshot Browse...
Network
Evont Playback Download  C-\UsersladminWebDownload\PlaybackRecord Browse. ..

1]

Video Clips C:\Users\admin\WebDownload\VideoClips Browse...
Storage

System Default ‘ | Save
Information

Figure 5-25

5.1.3 Audio

Please note some series devices do not support audio function.
5.1.3.1 Audio

The audio interface is shown as below. See Figure 5-26.

Audio

> Conditi
— Encode

Main Stream

Network [¥] Enable
Event Encode Mode G711A [~
Storage Sampling Frequency 16k
system

N Sub Stream
Information

7] Enable Sub Stream 1
Encade Made G.711A

Sampling Frequency 16k

— Altribute —
Audioln Type Lineln
Noise Filter Enable
Wicrophone Volume [=] O 50
Speaker Volume = U [£] 50
Default ‘ ‘ Refresh || Save |

Figure 5-26

Please refer to the following sheet for detailed information.



Parameter

Function

Enable

You can enable audio only when video is enabled.

After selecting the “Enable” of main stream or sub stream, the
network transmission stream is the audio/video composite
stream, otherwise it only includes video image.

Encode mode

The encode mode of the main stream and extra stream include
G.711A, G.711Mu, G.726 and ACC. The default mode is
G.711A.

The setup here is for audio encode mode and the bidirectional
talk encode both.

Sampling The sampling frequency of audio. It includes the following
Frequency options:
® 8K
® 16K
® 32K
® 48K
® 64K
Audioln Type Two modes to select: Lineln, Mic.
Device needs to connect external audio input source under
Lineln mode, and it doesn’t need to connect external audio
input source under Mic mode.
Noise Filter Enable the function and it can filter relevant noise.
Microphone Adjust microphone volume from 0~100.
Volume

Note:
Supported by some devices.

Speaker Volume

Adjust speaker volume from 0~100.
Note:
Supported by some devices.

5.1.3.2 Alarm audio




Alarm Audio

alarm1.pcm

C alarmz.pcm ()}

Network
Event
Storage
System

Information

Figure 5-27
add Audio Fila 3
= Record = Upload
Audio File | pcm
Record
Figure 5-28

Audio management currently supports PCM format to record and PCM, wav two forms to upload,
and can select an audio file for the audio alarm linkage.
The way to download the web alarm playback audio file into local is as follows:

Step 1 Use the left mouse button to click the hollow circle © in the “choice” column on the left,

and shows = , which means effective choice of alarm audio.

Step 2 Use the right mouse button to click : , select “save target as” to download.

5.2 Network

5.2.1 TCP/IP

The TCP/IP interface is shown as in Figure 5-29. It supports IPv4 and IPv6. IPv4 supports static IP and
DHCP. IPv6 supports static IP only. When users manually modify IP address, WEB will automatically
jump to the new IP address.



Camera TCP/IP

> Connection Ethernet Card

Host Name

> PPPoE hade
> DDNs MAC Address
> IP Filter IP Versian

> SMTP(Email) IP Address

EALELE Subnet mask

S Default Gateway

> Bonjour

> Multicast

Preferred ONS Server| 3 8

IPC

Wire(DEFAULT) = Set as Default

& Static © DHCP

90 ad 1c cl
172 . 29 36

255 . 255

172 . 29

2
0
0
8

Alternate DNS Server| § 8 4

> WIFl

¥ Enable ARP/Ping to set IP address service

> 802.1x

> QoS
Event
Storage
System
Information

Default ‘ ‘ Refresh ‘ ‘ Save

Figure 5-29
Please refer to the following sheet for detailed information.

Parameter Function

Host Name It is to set current host device name. It max supports 15
characters.

Ethernet Card Please select the Ethernet port. Default is wired.

Please note you can modify the default Ethernet card if there is
more than one card.

Mode There are two modes: static mode and the DHCP mode. Select
DHCP mode, it auto searches IP, and you cannot set IP/subnet
mask/gateway. Select static mode, you must manually set
IP/subnet mask/gateway.

Mac Address It is to display hose Mac address.

IP Version It is to select IP version. IPV4 or IPV6.

You can access the IP address of these two versions.

IP Address Please use the keyboard to input the corresponding number to
modify the IP address and then set the corresponding subnet
mask and the default gateway.

Preferred DNS DNS IP address.

Alternate DNS Alternate DNS IP address.




Enable
ARP/Ping set
device IP
address service.

You can use ARP/Ping command to modify or set the device IP
address if you know the device MAC address.

Before the operation, please make sure the network camera
and the PC in the same LAN. This function is on by default.

You can refer to the steps listed below.

Step 1: Get an IP address. Set the network camera and the PC
in the same LAN.

Step 2: Get the physical address from the label of the network
camera.

Step 3: Go to the Run interface and then input the following
commands.

arp —s <IP Address> <MAC>

ping -l 480 —t <IP Address>

Such as: arp -s 192.168.0.125 11-40-8c-18-10-11
ping -l 480 -t 192.168.0.125

Step 4: Reboot the device.

Step 5: You can see the setup is OK if you can see there are
output information such as “Reply from 192.168.0.125 ...” from
the command output lines. Now you can close the command
line.

Step 6: Open the browse and then input http://<IP address>.
Click the Enter button, you can access now.

5.2.1.1 Easydip

Click “Enable” to connect the device to network, and then you can connect to the device via mobile
client of Easy4ip after “Online” is displayed on the interface (connection mode: add device serial number

or scan QR code). See Figure 5-30.

Camera TCPIP

> Connection

[C] Enable

Status

> PPPoE
SN

> DDNS

OR Code
> IP Filter

> SMTP(Email)

> UPnP

> SNMP

> Bonjour

> b

3 C
> HTTPs
Event

storage

System

Information

Offling

1KO37FCPAW00213

‘ Default ‘ ‘ Refresh | | Save

Figure 5-30
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5.2.2 Connection

5.2.2.1 Connection

The connection interface is shown as in Figure 5-31.

Camera

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> M st

> HTTPs
Event

Storage

System

Information

Connection

Max Connection

(1-20)

TCP Port [37777 | (1025~85534)
UDP Port [3r778 (1025-85534)
HTTP Part |80 |

RTSP Port 554

HTTPs Port | 443

Default ‘ | Refresh ‘ | Save

Figure 5-31
Please refer to the following sheet for detailed information.
Parameter | Function
Max It is the max Web connection for the same device. The value ranges from 1
connection | to 20. Default connection amount is 10.
TCP port Port range is 1025~65534. The default value is 37777. You can input the
actual port number if necessary.
UDP port | Portrange is 1025~65534. The default value is 37778. You can input the
actual port number if necessary.
HTTP port | Port range is 1025~65524. The default value is 80. You can input the
actual port number if necessary.




RTSP port | ® The default value is 554. Please leave blank if use default. User uses
QuickTime or VLC can play the following formats. BlackBerry can play
too.

® Real-time monitoring URL format, please require real-time RTSP
media server, require channel no., bit stream type in URL. You may
need username and password.

® User uses BlackBerry need to set encode mode to H.264B, resolution
to CIF and turn off audio.

URL format is:
rtsp://lusername:password@ip:port/cam/realmonitor?channel=1&subtype=0
Username/password/IP and port.

The IP is device IP and the port default value is 554. You can leave it in
blank if it is the default value.

Follow standard RTP protocol and when encode mode is MJPEG, the max
resolution only supports 2040*2040.

HTTPs HTTPs communication port, range is 1025~65534, default is 443.
Port

Note:

® (0~1024, 37780~37880, 1900, 3800, 5000, 5050, 9999, 37776, 39999, 42323 are all special ports.
User cannot modify them.

® Avoid using default port value of other ports.

5.2.2.2 ONVIF

ONVIF (Open Network Video Interface Forum) , this standard describes network video mode,
interface, data type and data interaction mode. ONVIF Standard’s aim is to achieve a network video
frame agreement and makes the network video products (including video front-end, video equipment,
etc.) from different manufacturers completely compatible.

ONVIF function is on by default.



Camera Connection

Authentication @ ON ) OFF

Default |‘ Refresh

> IP Filter

> SMTP(Emaily
> UPnP

> SNMP

> Bonjour

> M st

> HTTPs
Event
Storage
System
Information

Figure 5-32

5.2.3 PPPoOE

The PPPOE interface is shown as in Figure 5-33.

Enter the PPPOE username and password which are provided by ISP (Internet Service Provider), and
click “Enable”. The network camera will automatically establish network connection in the mode of
PPPoE after it is enabled, after it is successful, the IP of the “IP Address” will be automatically modified
into the dynamic IP address of the acquired WAN.

Note:

After PPPoE dial-up is successful, it needs to log in the device via the IP which is set before dial-up; in

the PPPOE setup interface, it will display the registered IP address, and then it can visit the IP address
via client.

Please disable UPnP when clicking PPPOE enable, which is to avoid causing influence to PPPoE dial-
up.



> Connection
PPPoE

> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> SNMP

> Bonjour

> Multicast

> 802 1x

> QoS

Event

Storage

System

Information

5.2.4 DDNS

PPPOE

[] Enable
Username

Password

Figure 5-33

The DDNS interface is shown as in Figure 5-34.

The DDNS is to set to connect the various servers so that you can access the system via the server.
Please go to the corresponding service website to apply a domain name and then access the system
via the domain. It works even your IP address has changed. When the device connects to WLAN, you
should disable UPnP.

Camera

>

> Connection
> PPPoE

. DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

>
> HTTPs

Event

Storage

System

Information

DDNS

[C] server Type Dahua DDNS [+]

Server Address

Mode @ Auto ") Manual
Domain Name 2 E dahuaddns.com
Username (Optional)Please input the mailbox

Default H Refresh H Save

Figure 5-34

Please refer to the following sheet for detailed information.



Parameter

Function

Server Type

You can select DDNS protocol from the dropdown list: CN99
DDNS, NO-IP DDNS, Dyndns DDNS, Dahua DDNS, the default
is Dahua DDNS.

Server Address

DDNS server IP address

CN99 DDNS

Server address: www.3322.0rg

NO-IP DDNS

Server address: dynupdate.no-ip.com
Dyndns DDNS

Server address: members.dyndns.org
Dahua DDNS

Server address: www.dahuaddns.com

Mode

Default is auto, able to choose manual

Domain Name

Both auto and manual are “MAC addresss.dahuaddns.com”by
default, able to set prefix manually.

Username

The user name you input to log in the server, optional.

The CN99 DDNS interface is shown as in Figure 5-35.

Camera DDNS
Network
> TCPIP

[T Server Type

Server Address
> Connection

Domain Name
> PPPoE

> IP Fitter

Usemame

Password

> SMTP(Email) Update Period
> UPnP

> SNMP

> Bonjour

> Multicast

> 802 1x

> QoS

Event

Storage

System
Information

CN%9 DDNS

10 Minute (1~500)

Default | | Refresh | ‘ Save

Figure 5-35



http://www.3322.org/

Parameter Function

Server Type You can select CN99 DDNS protocol

Server Address | Under CN99 DDNS the default server address is “www.3322.org”

Domain Name Self-defined domain name

Username The user name you input to log in the server.

Password The password you input to log in the server

The refresh period of the connection between the device IP and the server, default

Refresh Period | 1016 minutes.

5.2.5 IP filter

The IP filter interface is shown as in Figure 5-36.

You can enable IP filter function so that some specified IP/MAC user can access the network camera.
You can add IP address or IP segment.

If you do not check the box here, it means there is on access limit.

Here you can add IP address and MAC address. You must add these addresses before enabling the
trusted sites.

Please note: You must set MAC address in the same network segment.

IP Filter

Trusted Sites
> TCPIP

Trusted Sites

> Connection 1P address /MAC address
> PPPoE
> DDNS
> SMTP(Email)
> UPnP
> SNMP

> Bonjour

> Multicast

> 8021x Add IP/MAG

> Qos

‘ Default | ‘ Refresh, | ‘ Save
Event

Storage

System

Information

Figure 5-36

5.2.6 SMTP (e-mail)
The SMTP interface is shown as in Figure 5-37.


http://www.3322.org/

SMTP(Email)

SMTP Server none

Port 25
> Connection

Anonymity

> PPPoE

> DONS Username

> IP Filter Passworg

SMTP(Email)

s Authentication None [=]
> SNMP

Sender none

Title Attachment
> Bonjour
Mail Receiver
> Multicast
> 802.1x
> QoS
Event Interval 0 Second (0~3600)
Storage [F] Health Mail Update Period Second (1~3600)
System
. Email Test
Information

[ et |[  Remesn J[  sae

Figure 5-37
Please refer to the following sheet for detailed information.
Parameter Function
SMTP Server Input server address and then enable this function.
Port Default value is 25. You can modify it if necessary.
Anonymity For the server which supports the anonymity email function, it

won'’t display the information of the sender.

The user name of the sender email account.

User Name

Password The password of sender email account.

Sender Sender email address.

Authentication You can select SSL, TLS or none.

(Encryption

mode)

Title (Subject) Input email subject here.

Attachment System can send out the email of the snapshot picture once

you check the box here.

Mail receiver Input receiver email address here. Max three addresses.




Parameter

Function

Interval

The send interval ranges from 0 to 3600 seconds. 0 means
there is no interval.

Please note system will not send out the email immediately
when the alarm occurs. When the alarm, motion detection or
the abnormity event activates the email, system sends out the
email according to the interval you specified here. This
function is very useful when there are too many emails
activated by the abnormity events, which may result in heavy
load for the email server.

Health mail
enable

Please check the box here to enable this function.

Email test

The system will automatically sent out a email once to test the
connection is OK or not .Before the email test, please save
the email setup information.

5.2.7 UPnP

It allows you to establish the mapping relationship between the LAN and the public network.

Here you can also add, modify or remove UPnP item. For UPnP on different routers, you must disable

UPNP function. See Figure 5-38.

In the Windows OS, From Start->Control Panel->Add or remove programs. Click the “Add/Remove
Windows Components” and then select the “Network Services” from the Windows Components Wizard.
Click the Details button and then check the “Internet Gateway Device Discovery and Control client” and

“UPnP User Interface”. Please click OK to begin installation.

Enable UPnP from the Web. If your UPnP is enabled in the Windows OS, the network camera can auto

detect it via the “My Network Places”.

Under manual mode, you can modify external port. Under auto mode, select idle port for auto port

mapping without user modification.




> TCPAP

> Connection

Service Name Protocol Internal Port External Port Status Modify
> PPPoE HTTP WebService TCP 80 8080 Mapping Failed A
> DDNS TCP PrivSenvice TCP 7T 3T Mapping Failed &
> IP Filter ubpP PrivService:UDP 37778 37778 Mapping Failed £
> SMTP(Email) RTSP RTSPService: TCP 554 554 Mapping Failed i

UPnP
> SNMP

> Bonjour

> Multicast

> 802 1x

> QoS

Event
Storage
System
Information

5.2.8 SNMP

UPnP

[C] Enable
Port Mapping List

Mode | Manual [x]

Router State Mapping Failed

Figure 5-38

The SNMP interface is shown as in Figure 5-39 and Figure 5-40.

The SNMP allows the communication between the network management work station software and the
proxy of the managed device. Please install the software such as MG MibBrowser 8.0c software or
establish the SNMP service before you use this function. You need to reboot the device to activate the

new setup.

SNMP

SNMP Version [[] SNMPv1 [7] SNMP v2 [] SNMP v3
> TCPIP _
> Connection SNMP Port 161 (1~65535)
> PPPoE Read Community public
> DDNS Write Community private
> IP Filter Trap Address
> SMTP(Email) Trap Port 162
> UPnP
> Bonjour

> Multicast
> 802.1x
> QoS
Event

Storage

System

Information

Figure 5-39

Please refer to the following sheet for detailed information.




Parameter Function

SNMP Version ® Check SNMP v1, device only process vl info.
® Check SNMP v2, device only process v2 info.

® Check SNMP v3, can set username, password and
encryption method. Server calibrate corresponding
username, password and encryption method too access
device and v1/v2 are unavailable.

SNMP port The listening port of the proxy program of the device. Itis a
UDP port not a TCP port. The value ranges from 1 to 65535.
The default value is 161

Community It is a string, as command between management and proxy, ,
defining a proxy, and a manager’s authentication.

Read-only access to all SNMP targets, default is public.
Note: Only number, letter, , and — supported.
Read/write access to all SNMP targets, default is private.
Note: Only number, letter, , and — supported.

The destination address of the Trap information from the
proxy program of the device.

Read community

Write community

Trap address

Trap Address Address where to send Trap message.

Port which send Trap message, default is 162, range

Trap Port
1~65535.

Camera SNMP
Network

SNMP Version SNMP v1 SNMP v2 SNMP v3
> TCPIP

> Connection SNMP Port 161 (1~65535)
> PPPOE Read Community public

> DDNS Wite Community private

> IP Filter Trap Address

> SMTP(Email) Trap Port 182

> UPnP

SNMP

> Bonjour Authentication Type @ MDs O SHA

Read-only Usemame public

> Multicast Authentication Password
> 802.1x Encryption Type @ CBC-DES
> QoS Encryption Password

Event

Storage Read&write Username private
system Authentication Type © MDE () SHA
Information Authentication Password

Encryption Type @ CBC-DES

Encryption Password

Deaut || Refesn ][ sae

Figure 5-40



Check SNMP v3 version and SNMP port, read community, write community, Trap address, Trap port
are same with SNMP v1 and SNMP v2 versions. Only when SNMP version is SNMP v3, users need
to configure parameter in chart.

Parameter Function

SNMP Version | SNMP v3

Read-only Bﬁ{gylt is public.

Username Name only can be number, letter and underline.
Read/\Write Bﬁ{gylt is private.

Username Name only can be number, letter and underline.
Authentication | You may select MD5 or SHA, default is MD5.
Authentication Password not less than 8 characters.

Password

Encryption Default is CBC-DES.

Encryption Password not less than 8 characters.

Password

5.2.9 Bonjour

The Bonjour interface is shown as below. See Figure 5-41.

Bonjour is based on the multicast DNS service from the Apple. The Bonjour device can automatically
broadcast its service information and listen to the service information from other device.

You can use the browse of the Bonjour service in the same LAN to search the network camera device
and then access if you do not know the network camera information such as IP address.

You can view the server name when the network camera is detected by the Bonjour. Please note the
safari browse support this function. Click the “Display All Bookmarks: and open the Bonjour, system can
auto detect the network camera of the Bonjour function in the LAN.

Camera
Network

> TCPAP

> Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Multicast

> 802.1x

> Qos
Event
Storage
System
Information

Bonjour

Enable

Server Name PZC1EW24200002

Detaut |




Figure 5-41

5.2.10 Multicast

The multicast interface is shown as in Figure 5-42.

Multicast is a transmission mode of data packet. When there is multiple-host to receive the same data

packet, multiple-cast is the best option to reduce the broad width and the CPU load. The source host

can just send out one data to transit. This function also depends on the relationship of the group

member and group of the outer.

Note:

® Open preview, streaming media protocol, select multicast, and monitor via multicast format.

® Here you can set multicast address and port. You also need to go to Live interface to set the
protocol as Multicast.

Multicast

Main Stream

Sub Stream

Enable Enable

> Connection

Muiticast Address 224 . 1 . 2 . 4 |(224.0.0.0~239.255.255.255) Multicast Address 224 .1 2 . 4 |(224.0.0.0~239.255.255.255)
> PPPoE

Port 40000 (1025~65534) Port 40002 (1025~65534)
> DDNS

> IP Filter

> SMTP{Email) Refresh
> UPnP
> SNMP

> Bonjour
> 802 1x
> QoS
Event

Storage

system

Information

Figure 5-42

Please refer to the following sheet for detailed information.

Parameter Function

Enable Select to enable multicast function. Main stream and sub stream cannot be
used at the same time.

Multicast address Main/sub stream multicast default address is 224.1.2.4 and its range is
224.0.0.0~239.255.255.255.

Port Multicast port. Main stream is 40000, sub streaml is 40016,sub stream?2 is
40032 and the range is 1025~65534.

5.2.114G




Note: This function is only for series with 4G module.
4G is a mobile communication system which makes wireless communication integrates with
Internet and multimedia communication.

5.2.11.1 Dialing Setting

Camera Dialing Setting

Mobile Settings

5 Wireless NetType | Auto E| [¥] Enable
> Connection APN 3gnet
> DDNS Authorize Mode No
> IP Filter Dial-up Number .*99#
> SMTP(Email) Username
> UPnP Password
7 Dt Update Period 30 ke
> Multicast Time Range
> Qos
_ Wireless Network State
IP Address
Event
Storage Wireless Signal WCDMA 0%
System FDD-LTE pE— 70%
Information Default | ‘ Refresh | | Save

Wireless Net Type

Auto, WCDMA, FDD-LTE optional, you can select according
to the operator.

Enable

Check to enable 4G module.

APN

It shall be acquired from the operator according to the setup
of operator.

Authentication Mode

Auto, PAP and CHAP, the authentication algorithm is
different according to different operators.

Dial-up Number

The number is different according to different operator, it can
be acquired from operator.

User name

It shall be acquired from the operator.

Password

It shall be acquired from the operator.

Update Period

It is the period beyond the dial-up period which has been
set, it is 30s by default, which means the device can auto
acquire 4G dial-up status, cut off dial-up to save flow.




Time Range It is the time period to set dial-up. It can activate the function
via message to enable/disable dial-up function if it is
beyond the time period.

IP Address It will display the acquired IP after the dial-up is successful

via 4G.

5.2.11.2 Mobile Setting

Camera Dialing Setting

> TCPIP
> Connection Receiver
> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> Bonjour

> Multicast

> Qo8

Event

Storage

System

Information

Mobile Settings

[ Message Send

[T] Wessage Activation [} Phone Activation

i Sender * Caller

Title Event Message

Detaut || Remesn || save

Figure 5-44

Please refer to the following sheet for detailed information.

Parameter

Function

Message Send

In the event, after the corresponding message activation is
enabled, it will send message to the phone of receiver when
event happens. It needs to enable the function of message
activation function in the event interface when using the
function.

Message
Activation

It can send message ON/OFF to the SIM card inside the device by
the mobile phone in the list, which is to enable /disable the dial-up
function and send REBOOT to restart the device.

Phone Activation

You can use the mobile phone in the calling list to call the SIM card
inside the device to enable dial-up function.

5.2.12 WIFI




Note:

Some series devices don’t support WIFI and WPS function.
WPS function is supported by the devices with WPS button.

5.2.12.1 WIFI

WIFI info can show the name, status, IP information of the Current Hot Spot. Usually please “Refresh”
WIFI work information after reconnection to ensure the real-time display of the work status, because it
often takes some time to connect WIFI Hot Spot, which depends on the network signal strength.

Camera

> T P

> Connection
> PPPOE
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> SMTP(Email)
> UPnP
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> Bonjour

> Multicast

> 8021x

> QoS
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System
Information

WIFI

I Enable [ sgessn, || searnssio |

WIFI INFO
Current Hot Spot
IP address
Subnetmask

Default Gateway

Figure 5-45

WIFI setting method is as follows:

Step 1 Click

™ Enable ¥ Enable _ _
, show as , means enabling WIFI function.

Step 2 Click “ Search SSID”, and shows the wireless network hot spot of the current network camera
environment in the list.
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> TCPIP

> Connection
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> IP Filter

> SMTP(Email)
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> Bonjour

> Multicast

bd

> QoS
Event
Storage
System
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Step 3 Click “Add SSID” when need to add a wireless network manually pop out an interface in
the figure below, and enter network ID in the dialog box.

WIF1

¥ Enable

12345
5370test
TP-LINK_465EF6
AndroidAP
TP-LINK_425796
MNETGEARG4

TP-LINK_MIJIAN

Add 581D

H Search 551D |

WPA-PSK-AES
WPAWPA2-PSK-TKIP+AES
WPA-PSK-TKIP+AES
WPA2-PSK-AES
WPAWPA2-PBK-TKIP+AES
NONE

WPAWPA2-PSK-TKIP+AES

WIFI INFO

CurrentHot Spot  unconnected
IP address

Subnetmask

Default Gateway

Figure 5-46

Add Wireless SSID

SSID

Ok

Cancel

B

Figure 5-47

Step 4 Double click on one can pop out the signal intensity and authentication of the hot spot.

+ Please enter the password if necessary. Please keep the choice of password index number

same as the router when entering password.

* Please click “connect” if it is unnecessary to enter the password.

5.2.12.2 WPS
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Figure 5-48
PIN Number and SSID are both acquired from the router, please “refresh” the work information of WIFI
to ensure the real-time display of work state after filling in correctly.
5.2.13802.1x
802.1x (port based network access control protocol) supports manual selection of authentication
method to control if device connected to LAN can join the LAN. It well supports authentication, charging,
safety and management requirement of network.

802.1x

7] Enable

> TCPAP

Authentication
> Connection

Usemame
> PPPoE

Password
> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> SNMP
> Bonjour
> Mulicast
> QoS
Event

Storage

System

Information

Figure 5-49

Please refer to the following sheet for detailed information.



Parameter Function

Authentication | PEAP (protected EAP protocol).

Username It needs the username to login, which is authenticated by the
server.
Password Please input password here.
5.2.14 QoS

The QoS interface is shown as below. See Figure 5-50.

Qos (Quality of Service) is network security mechanism. It is a technology to fix the network delay and
jam problem and etc. For the network service, the quality of service includes the transmission bandwidth,
delay, the packet loss and etc. We can guarantee the transmission bandwidth, lower the delay, and
reduce the loss of the data packet and anti-dither to enhance the quality.

We can set the DSCP (Differentiated Services Code Point) of the IP to distinguish the data packet so
that the router or the hub can provide different services for various data packets. It can select the
different queues according to the priority (64 different priority levels) of the packets and select the
bandwidth of the each queue. Level 0 is the lowest, and level 63 is the highest. It can also discard at the
different ratio when the broad bandwidth is jam.

Camera Qos
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Realtime Monitor
> TCPAP

Command
> Connection

> PPPoE

> DDNS
> IP Filter
> SMTP(Email)
> UPnP
> SNMP
> Bonjour
> Multicast
> 802 1x
[ o |
Event

Storage

System

Information

Figure 5-50
Please refer to the following sheet for detailed information.
Parameter Function
Real-time The value ranges from 0 to 63. The router or the switcher can

monitor provide different service for various data packets.




Parameter Function

Command The value ranges from 0 to 63. The router or the switcher can
provide different service for various data packets.
Enable Check it to enable QoS.
Wireless QoS
5.2.15HTTPs

In the HTTPs setting interface, users can make PC log in normally via HTTPs by creating certificate or

uploading signed certificate, which is to guarantee the security of communication data and provide

safeguard for user information and device security with reliable and stable technical means.

Step 1

Create certificate or upload the signed certificate.

® Please refer to the following steps if you select “Create Certificate”.

1. Select “Setup > Network > HTTPs”, and the system will display the interface of HTTPs, which is
shown in Figure 5-51.
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Certificate Installed

Certificate Installed l:l

Aftribute

Storage Refresh H Save
System
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Figure 5-51
2. Click “Create” and it will pop out the dialog box of “HTTPs”, which is shown in Figure 5-52.



HTTPs X
Country CN *e.q.CN
IP or Domain name | 10.15.15.211| 2
Validity Period 365 Day*Range :1-5000
Province ‘none
Location none
Organization ‘none
Organization Unit none
Email
Creat Cancel
Figure 5-52

3. Fillin corresponding “Country”, “Province” and some other information, click “Create” after filling in.
It will show the prompt of “Create Successfully”, which means the server certificate has been
successfully created.

Note:

Make sure the “IP or domain name” is the same as that of the device.

4. Click “Install” and it will install the certificate on the device end, which is shown in Figure 5-53.



Camera

> TCPIP [C] Enable HTTPs
> Connection Create Certificate

7R Request Created
> IP Filter

Request Created HP=10.15.15.211,C=CN:ST=none ,L=no z e Delete | | ‘ ‘ Download
> SMTP{Email)

Install Signed Certificate

> UPnP
3 SMMP Certificate Path
> Bonjour Ceriificate Key Path B BE | ploz ‘
> Multicast Certificate Installed

Cerlificate Installed IP=10.15.15 = =none:L=none;C=none

Attribute Issue to: HAP=10.15.15.211; C=CN; 8T=nong;

i

L=none; O=none; OU=none; EM=;
Issuer: HIP=test, C=CN; ST=test, L=test, O=test, -

Event

Storage Refresh || Save

System

Information

Figure 5-53
5. Click “Download”. It will pop out the dialog box of “Save as”, save the file into the computer.

€ Save As -l (3
@Q'l = Librfries » v | 4’ | | Search Libraries p '
v @.

]

Organize ¥

I Desttop ~  Libraries

ARl Open a library to see your files and arrange them by folder,...

=| Recent Places ‘*

—

& Documents

4 \'J;‘J.ibraries \y/ Library
|| Documents
> JV Music ﬁ Music
I k= Pictures \L/ Library
E Videos 2 -
N Lbrary

4 (M Computer

7
> &y Local Disk (C:) @ Vitioe
P ¢ DISK1_VOL2 (D:) S Library
> DISK1_VOLS (E:) g
File name: RootCert.cer -
Save as type: | (*.cer) v]

4 Hide Folders [ Save ] [ Cancel ]

Figure 5-54



6. Double click the downloaded icon of “RootCert.cer”. The system will display the information
interface of “Certificate”, which is shown in Figure 5-55.

Certificate ﬂ

General | Details | Certification Path |

@g Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to: test

Issued by: test

Valid from 2016/ 7/ 8 to 2020/ 7/ 7

|Insta|l Certiﬁcate...] Issuer Statement

[ oc ]

Figure 5-55
7. Click “Install Certificate” and it will pop out the interface of “Certificate Import Wizard”, which is
shown in Figure 5-56.



Certificate Import Wizard &

Welcome to the Certificate Import
Wizard
This wizard helps you copy certificates, certificate trust

lists, and certificate revocation lists from your disk to a
certificate store.

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept.

To continue, dick Next.

Figure 5-56
8. Click “Next”. Select “Trusted Root Certification Authorities”, which is shown in Figure 5-57.



E
s

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
@ Place all certificates in the following store

Certificate store:
Trusted Root Certification Authorities I Browse.., l

Learn more about certificate stores

| <Back | mNext> | | cancel |

Figure 5-57
9. Click “Next”. The system will display the interface of “Completing the Certificate Import Wizard”,
which is shown in Figure 5-58.



Completing the Certificate Import
Wizard

The certificate will be imported after you dick Finish.

You have specified the following settings:

Cerfificate Store Selected by User IR = Gl 4@ gi)iles
Content Certificate
< AN »

<Back || Finsh | | cancel

Figure 5-58
10. Click “Finish”, and it will pop out the dialog box of “Security Warning”, which is shown in Figure 5-59.



Se;urity Warning

A

You are about to install a certificate from a certification authority (CA)
claiming to represent:

test

Windows cannot validate that the certificate is actually from "test”. You
should confirm its origin by contacting "test". The following number
will assist you in this process:

Thumbprint (shal): 6D811FD2 E82313A8 663514ED 2CA36E6B 7D425FA6
Warning:

If you install this root certificate, Windows will automatically trust any
certificate issued by this CA. Installing a certificate with an unconfirmed

thumbprint is a security risk. If you click "Yes" you acknowledge this
risk.

Do you want to install this certificate?

Yes No

Figure 5-59

11. Click “Yes”. It will pop out the dialog box of “Import Successful”, click “Ok” to complete downloading
certificate, which is shown in Figure 5-60.

Certificate Import Wizard ﬂ

l The import was successful.

Figure 5-60

® Please refer to the following steps if you select “Install Signed Certificate”.
1. Select “Setup > Network > HTTPs”. The system will display the interface of HTTPs, which is shown
in Figure 5-61.
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Storage Refresh || Save
System
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Figure 5-61

2. Select signed certificate and certificate key path respectively via “Browse”, click “Upload”.

3. Install root certificate, please refer to step 6~11 for more details.

4. Check “Enable HTTPs”, click “Save”. The system will display the dialog box of “Need to reboot the
device”, and then the config is valid.

Reboot

A The configuration takes effect, the device is restarting now, please don't leave this page or close the browser...

Figure 5-62
5. Use HTTPs
Use HTTPs to log in.
Enter https://xx.xx.xx.xx in the browser, and it will pop out normal login interface; the browser will prompt
certificate error if the certificate is not installed, which is shown in Figure 5-63.



https://xx.xx.xx.xx/

)l - & hittp=//101515.211/

O

File Edit View Favorites Tools Help

¢ Favorites | o [B] B v ) MEESHE v

‘ (& Certificate Error: Navigation Blocked |

[@ There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authority.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
server,

We recommend that you close this webpage and do not continue to this website.
'f@ Click here to close this webpage.

'Ei' Continue to this website (not recommended).

& More information

Figure 5-63
Note:
“xx.xX.xx.xx” is corresponding to your IP or domain name.

5.3 Event

5.3.1 Video detection

5.3.1.1 Motion Detection

Step 1

Select “Setup > Event > Video Detection > Motion Detection’ and the system will display the interface of
“Motion Detection” which is shown in Figure 5-64.
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Figure 5-64

Step 2

Select “Enable” to enable motion detection function.
Step 3

Set motion detection area.

1. Click “Setup” and the system will pop out the interface of “Setting Area”, which is shown in Figure 5-
65
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Threshold (=) {}——————(@) 5

Figure 5-65

2. Set area name, itis to set valid area of motion detection according to the actual situation, and it can
set the value of sensitivity and threshold respectively.
The bigger the sensitivity is, the easier it is to generate motion detection, the smaller the threshold is,
the easier it is to generate motion detection; the entire video image is the valid area of motion
detection by default.

Note:

® Different colors represent different areas; each area can set different detection area.

® The red line in the Oscillogram means triggering motion detection; green line means not triggering
motion detection.

3. Click “Save” to complete area setting.

Step 4

It is to set other parameters of motion detection, please refer to the following sheet for more details.



Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Anti-dither

System only memorizes one event during the anti-dither period. The value
ranges from 0s to 100s.

Area

1. Click “Setup” and the system will pop out the interface of “Set Area”.

2. Setthe area name, it is to set the valid area of motion detection
according to the actual situation, and it can set its sensitivity and
threshold respectively. The higher the sensitivity is, the easier it is to
trigger motion detect, the smaller the area threshold is, the easier it is
to generate motion detect, the whole video image is the valid area of
the motion detect by default.

Note:

Different colors represent different areas; each area can set different

detection areas.

The red line in the Oscillogram means triggering motion detect, the green

line means not triggering motion detect.

3. Click “Save” to complete area setup.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The|
value ranges from 10s to 300s.

Send Email If you enabled this function, System can sgnd out err_1ai| to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Audio linkage Check it and the system will play alarm a.udi.o file when ala.rm occurs..Use
can set the recorded or uploaded audio file in “camera setting > audio >
alarm audio”.

Flash linkage Check it and the flash will be on when alarm occurs, and the flash will

be off until the end of alarm after corresponding delay.




Parameter Function

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.

® The event type includes: preset, tour and pattern.

You need to check the box here so that system can backup motion detectior

snapshot file. You shall set snapshot period in Storage>Schedule.

Snapshot

Step 5
Click “Save” to complete the setting of motion detection.

5.3.1.2 Video Tampering

Step 1

Select “Setup > Event > Video Detection > Video Tampering” and the system will display the interface of
“Video Tampering” which is shown in Figure 5-66.

Camera Motion Detection JVideo Tampering] Scene Changing
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. Video Detaction
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System
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Figure 5-66
Step 2
Set the parameter of video tampering; please refer to the following sheet for more details.
Parameter Function
Enable video You need to check the box to enable video mask detection alarm.
tampering

Enable defocus | You need to check the box to enable defocus detection alarm.
detection




Parameter Function

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Check it and so when alarm occurs, system will auto record. You shall set

Working Period

Record
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The

value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when

alarm occurs and ends. User can set email address in Network>SMTP.

Check it and the system will play alarm audio file when alarm occurs. Use

can set the recorded or uploaded audio file in “camera setting > audio >

alarm audio”.

Check it and the flash will be on when alarm occurs, and the flash will

be off until the end of alarm after corresponding delay.

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.

® The event type includes: preset, tour and pattern.

You need to check the box here so that system can backup motion detectior

shapshot file. You shall set snapshot period in Storage>Schedule.

Audio linkage

Flash linkage

Snapshot

Step 3
Click “Save” to complete the setup of video tampering.

5.3.1.3 Scene Changing

Step 1

Select “Setup > Event > Video Detection > Scene Changing” and the system will display the interface of
“Scene Changing” which is shown in Figure 5-67.
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Figure 5-67

Check “Enable” to enable the function of scene changing.

Step 3

It is to set the parameters of scene changing, please refer to the following sheet for more details.

Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The|
value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when

alarm occurs and ends. User can set email address in Network>SMTP.




Parameter Function

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.

® The event type includes: preset, tour and pattern.

Snapshot You need to check the box here so that system can backup motion detectior

snapshot file. You shall set snapshot period in Storage>Schedule.

Step 4
Click “Save” to complete the setup of scene changing.

5.3.2 Audio Detection
Step 1

Select “Setup > Event > Audio Detection” and the system will display the interface of “Audio Detection”
which is shown in Figure 5-68.
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Figure 5-68
Step 2

It is to set the parameters of audio detect, please refer to the following sheet for more details.

Parameter Function
Enable input Select “Enable Input Abnormal” and it will trigger alarm when it detects
abnormal audio input abnormity.

Enable intensity | Select “Enable Intensity Change” and it will trigger alarm when it detects
change that audio intensity change exceeds the threshold.




Parameter

Function

Sensitivity It can be judged as audio abnormity when the input volume change
exceeds continuous environment volume; users need to adjust according
to the actual environment test.

Threshold It is to set the filtered environment volume intensity, if the environmental

noise is too big, then the value needs to be set higher, users can adjust
according to the actual environment test.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Anti-dither

System only memorizes one event during the anti-dither period. The value
ranges from 0s to 100s.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can sgnd out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to

preset x when there is an alarm.

® The event type includes: preset, tour and pattern.

Snapshot You need to check the box here so that system can backup motion detectior
snhapshot file. You shall set snapshot period in Storage>Schedule.

Step 3

Click “Save” to complete the setup of audio detection.



5.3.3 Smart Plan

Smart plan is the master switch for intelligent analysis such as “Face Detection”, “Heat Map”, “IVS”,
“People Counting” and so on, the corresponding intelligent functions can be valid after smart plan is
enabled.

Step 1

Select “Setup > Event > Smart Plan”. The system will display the interface of “Smart Plan”, which is
shown in Figure 5-69.
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Figure 5-69
Step 2
Click “Save” to complete the config of smart plan.

5.3.4 Intelligence Behavior Analytics

The basic requirements of scene selection.

® The total proportion of the target shall not exceed 10% of the image.

® The target size in the image can't be less than 10 pixel X 10 pixel, the size of abandoned target
can’t be less than 15 pixel X 15 pixel (CIF image); The height and width of the target can’t exceed
1/3 of the image; it is recommended that the target height is about 10% of the image height.

® The difference of brightness value between target and background can’t be less than 10 gray levels.

® Make sure the target appears at least over 2 seconds continuously in the field; the movement
distance has to be bigger than the width of the target itself and makes sure it is no less than 15
pixels (CIF image).

® Try to lower the complexity of the monitoring scene analysis if it is possible; it is not advised to use
IVS functions in the environment where the targets are dense and light change is very frequent.

® Try to keep away from the areas such as glass, ground reflected light, water surface, branch,
shadow, mosquito disturbance and etc. try to keep away from the backlight scene to avoid direct
light.



5.3.4.1 IVS

5.3.4.1.1 Tripwire

It will trigger alarm when the target crosses the warning line according to the movement direction which
has been set.

It needs some time from when the target appears to when the target is confirmed, so it has to leave
some space on both sides of the warning line when setting the warning line, please do not set the
warning line near the obstructions.

Application scene: it can be applied to the scene with sparse target and there is barely any blocks
between the targets, such as the unmanned perimeter defense.

Step 1

Select “Setup > Event > IVS > IVS” and the system will display the interface of “IVS”.

Step 2

Click to set rule name and select the rule type as “Tripwire” which is shown in Figure 5-70.
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Step 3
Click “Draw Rule” to draw tripwire in the monitoring scene, click the right mouse button to complete
tripwire setting.
Step 4
Click “Draw Target” to draw the size model of filtered target in the video image.
Step 5
It is to set the parameters of tripwire, please refer to the following sheet for more details.



Parameter

Function

Object tracking

Select “Object tracking” to enable the function, refer to “2.4 Video Window
Adjustment” for more details.

Note:
The function is only supported by some models.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Direction

It is to set the direction of tripwire, you can select A->B. B->A. A<->B.

Object Track

Select “Object Track” and it will enable the function of object track; when the
moving object triggers rule and generates alarm, it will select the display
mode of object track such as 1P+3 or 1P+5 in the preview interface, the
scene of tracking window will follow the moving object till the object leaves
the view range of the camera. Please refer to “2.4.8 Fisheye/Trigger Track”
for more details.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.

Step 5

Click “Save” to complete the setup of tripwire.

5.3.4.2 Intrusion

Intrusion includes cross and appears.




® Cross means that it will trigger alarm when the target enters or exits the area.

Appears means that it will trigger alarm when the target appears in the area.

® As for the report interval of the IVS function in the area, the system will trigger an alarm if it detects
same event happened during the interval; the alarm counter will become zero if there is no same
event happened in the interval.

It needs to leave some space for target movement for the area periphery if it is to detect enter & exit

event, which is similar to the warning line.

Application scene; it can be applied to the scene where the target is sparse and there is barely any

obstruction between the targets, such as the unmanned perimeter defense.

Step 1

Select “Setup > Event > IVS > IVS” and the system will display the interface of “IVS”.

Step 2

Click to set rule name, select the rule type as “Intrusion” which is shown in Figure 5-71.
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Step 3
Click “Draw Rule” to draw an area in the monitoring image.
Step 4
Click “Draw Target” to draw the size model of filtered target in the video image.
Step 5

It is to set the parameters of intrusion, please refer the following sheet for more details.



Parameter

Function

Object tracking

Select “Object tracking” to enable the function, refer to “2.4 Video Window
Adjustment” for more details.

Note:
The function is only supported by some models.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Action

It is to set the action of intrusion, you can select appears and cross.

Direction

It is to set the direction of intrusion, you can select enter, exit and
enter&exit.

Object Track

Select “Object Track” and it will enable the function of object track; when the
moving object triggers rule and generates alarm, it will select the display
mode of object track such as 1P+3 or 1P+5 in the preview interface, the
scene of tracking window will follow the moving object till the object leaves
the view range of the camera. Please refer to “2.4.8 Fisheye/Trigger Track”
for more details.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can s_end out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.

Step 5

Click “Save” to complete the setup of intrusion.




5.3.4.3 Abandoned Object

Abandoned object means the system will trigger alarm if the abandoned object in the monitoring scene
exceeds the time which has been set by the users.

Abandoned object and missing object can be confusing in a situation where both foreground and
background are complicated.

It also triggers alarm as abandoned object if there is pedestrian or vehicle staying still for too long. In
order to filter this kind of alarm, generally the abandoned object is smaller than people and vehicle;
therefore it can filter the people and vehicle via setting size. Besides, it can avoid the false alarm
caused by short stay of people via extending alarm time properly.

Application scene: It can be applied to the scene where the target is sparse and there is no obvious and
frequent light change. False alarm will be increased in the scene with high target density and frequent
blocking; false alarm will be increased in the scene where there are more people staying. As for the
detection area, try to make it simple, the function is not suitable for the area which is too complicated.
Step 1

Select “Setup > Event > IVS > [VS” and the system will display the interface of “IVS”.

Step 2

Click to set rule name, select the rule type as “Abandoned Object” which is shown in Figure 5-72.
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Step 3
Click “Draw Rule” to draw an area in the monitoring area.
Step 4
Click “Draw Target” to draw the size model of filtered target in the video image.
Step 5

It is to set the parameter of abandoned object, please refer to the following sheet for more details.



Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Keep time

It is to set the shortest time from when the object is abandoned to when it
triggers alarm.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.

Step 5

Click “Save” to complete the setup of abandoned object.

5.3.4.4 Missing Object

Missing object means the system will trigger alarm if it exceeds certain amount of time after the target is

taken away from the original scene.

The system can make statistics of the still areas in the foreground area and distinguish if it is missing
object or abandoned object according to the similarity between foreground and background, it will
trigger alarm when it exceeds the time which is set by users.

Because the system distinguishes abandoned object from missing object according to the similarity of
foreground and background, it may cause error between abandoned object and missing object in a
situation where both foreground and background are complicated.




Network Camera Web 3.0 Operation Manual

Application scene: it can be applied to the scene where the target is sparse and there is no obvious and
frequent light change. False alarm will be increased in the scene where the target density is high and
there is frequent obstruction; the false alarm will be increased in the scene where there are more
people staying. As for the detection area, try to make it simple, the function is not suitable for the area
which is too complicated.

Step 1

Select “Setup > Event > IVS > IVS” and the system will display the interface of “IVS”.

Step 2

Click to set rule name and select rule type as “Missing Object”, which is shown in Figure 5-73.
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Step 3
Click “Draw Rule” to draw an area in the monitoring scene.
Step 4
Click “Draw Target” to draw the size model of filtered target in the video image.
Step 5

It is to set the parameters of missing object, please refer to the following sheet for more details.



Parameter Function

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Working Period

Keep time It is to set the shortest time from when the object is missing to when it
triggers alarm.

Record Check it and so when alarm occurs, system will auto record.

Record Delay System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so

that system can activate corresponding alarm device when alarm occurs.

System can delay the alarm output for specified time after alarm ended.

Alarm Delay
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.
Step 5

Click “Save” to complete the setup of missing object.

5.3.5 Face Detection

Step 1

Select “Setup > Event > Face Detection” and the system will display the interface of “Face Detection”,
which is shown in Figure 5-74.
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Step 2
Select “Enable” to enable face detection function.
Step 3

Click “Draw Target” to draw the size model of target filter in the video image.
Step 4
It is to set the parameters of face detection, please refer to the following sheet for more details.

Parameter Function

Working Period | Note: o _ _
It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Enable Face Select “Enable Face Enhancement” and it will guarantee that the face is
Enhancement clear by priority when the stream is set very low.
Record Check it and so when alarm occurs, system will auto record.

Record Delay System can delay the record for specified time after alarm ended.




Parameter Function

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended.
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when

alarm occurs.

Step 5
Click “Save” to complete the setup of face detection.

5.3.6 People Counting

5.3.6.1 People Counting

Step 1

Select “Setup > Event > People Counting > People Counting” and the system will display the interface
of “Entrance/Exit”, which is shown in Figure 5-75.
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Step 2
Select “Enable” to enable statistics function of entrance and exit.
Step 3



Click “Draw Rule” to draw an area in the monitoring image.

Step 4
Click “Draw Target” to draw the size model of filtered target in the video image.
Step 5
It is to set the parameters of entrance and exit, please refer to the following sheet for more
details.
Parameter Function
Enable OSD Select “Enable OSD” and it will display the people number statistics of

entrance and exit in the monitoring image.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.
1. Click “Setup” and the system will pop out the interface of “Working

Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).
3. Click “Save” to complete the setup of working period.

It is to select wall mount if there is an angle between device lens and

Installation ; A ) .
Mode horizontal surface, select ceiling if the device lens face downward vertically.
Rule Name It is to set the name of rule.

Direction It is to select the direction of entrance and exit statistics; A->B or B->A, the

arrow direction always means the entrance direction.

Flowrate Alarm

It is to set the enter number, leave number, stranded number; it will trigger
alarm when it exceeds the limited number.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can s<_end out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.

Step 6

Click “Save” to complete the setup of people counting.




5.3.6.2 Report

It is to generate a form of report according to the number statistics.

Step 1

Select “Setup > Event > People Counting > Report “and the system will display the interface of “Report’,
which is shown in Figure 5-76.
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Step 2
It is to set search condition, please refer to the following sheet for more detalils.

Parameter Note

Can select day report, month report and year report; also can select bar chart or line

Report Type | chart to display the report.

Time It can set the begin /end time within the range of statistics time.

It can select enter, leave and display number; the data of checked item can be

Flow Direction displayed in the report.

Search Search flow statistics data according to the setting to form report.
Export Export the saved report.
Step 3

Click “Search” to complete report statistics, click “Export” to export the report.

5.3.7 Heat Map

5.3.7.1 Heat Map

It is the density statistics of moving object that can generate report, the color range is from blue to red,
blue means the min heat value and red means the max heat value.

Mirroring, view angle change and heat map original data will be cleared.



Step 1
Select “Setup > Event > Heat Map > Heat Map” and the system will display the interface of “Heat Map”,
which is shown in Figure 5-77.
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Step 2
Select “Enable” to enable heat map function.
Step 3
It is to set the working period.
1. Click “Setup” and the system will display the interface of “Working Period”, which is shown in Figure
5-78.
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2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to drag on the setup interface to
set.

® There are six periods to be set every day, select the check box in front of the period, and then the
period is valid.

® Select week number (it selects Sunday by default, if it selects the whole week, then it means the
setup can be applied to the whole week, you can also select the check box in front of the week
number to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Step 4
Click “Save” to complete the setup of heat map.

5.3.7.2 Report

It is to generate the form of report according to the heat map data.

Step 1

Select “Setup > Event > Heat Map > Report” and the system will display the interface of “Report”, which
is shown in Figure 5-79.
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Step 2
Itis to set begin time and end time.
Step 3

Click “Search” to complete report statistics, click “Export” to export the statistics report.

5.3.8 Alarm
Please note some series products do not support this function.

5.3.2.1 PIR alarm

The alarm activation interface PIR alarm is shown as in figure 5-80.
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Please refer to the following sheet for detailed information.
Parameter Function
Enable After enabled, relay activation will work. Check it and enable the
PIR alarm.
Working ® This function becomes activated in the specified periods.
period ® There are six periods in one day. Please draw a circle to
enable corresponding period.
® Select date. If you do not select, current setup applies to
today only. You can select all week column to apply to the
whole week.
® Click OK button, system goes back to motion detection
interface; please click save button to exit.
Note: User can set via dragging mouse while not releasing left
mouse.
Anti-dither System only memorizes one event during the anti-dither period.
The value ranges from 0s to 100s.
Flash After enabling, the system will automatically turn on the flash
when alarm occurs.
Flash Delay e The flash will be off with a period of time delay when the
alarm linkage is over.
e Time is calculated by unit of second and ranges from
10s~300s.
Record System auto activates motion detection channel to record once

alarm occurs (working with motion detection function).

Record Delay

System can delay the record for specified time after alarm ended.
The value ranges from 10s to 300s.




Parameter Function

Enable alarm activation function. You need to select alarm output

Relay out ) X .
port so that system can activate corresponding alarm device when
alarm occurs.

Alarm delay System can delay the alarm output for specified time after alarm
ended. The value ranges from 10s to 300s.

Send Email After this function is enabled, system can send out email to alert

you when alarm occurs and ends.

Audio Linkage | Check it and the system will play alarm audio file when alarm
occurs. Users can set recorded audio file in “Camera Setting >
Audio >Alarm Audio”.

Snapshot After you enabled snapshot, the system will automatically
snapshot if alarm occurs.

5.3.8.1 Alarm Linkage
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Parameter Function
Enable Check it and enable the alarm linkage.
Relay-in The default alarm 1, some products can choose alarm 2.

Two types of sensor which are normally open (NO) and normally closed (NC),
Sensor Type switch from normally open to normally closed, open the alarm. Switch from normally
closed to normally open, shut the alarm.




Parameter Function

Check it and set PTZ movement when alarm occurs. Such as go to preset x when
PTZ there is an alarm.

The event type includes: preset, tour and pattern and so on.

5.3.8.2 Flash Set
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Parameter Function
ON/OFF ON means flash is on; OFF means flash is off.
Weak-strong Via dragging this bar to adjust flash brightness.
bar
All Check and it means the day flash works.
Period Period that flash is on.

5.3.8.3 Audio detection

Note: Audio detection won’t work when “Talk” is enabled on the preview interface.
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parameter Function

Enable Check it and enable audio detection.

It will trigger alarm and set up a series of linkage when volume exceeds the set

Threshold threshold.

5.3.9 Abnormity

Abnormity includes No SD Card, Capacity Warning, SD Card Error, Disconnection, IP Conflict and
Unauthorized Access.

Note:

Only device with SD card function has these three statuses: No SD card, capacity warning, and SD card
error. Device without SD card function does not have the above three statuses. See Figure 5-84 to
Figure 5-86.
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Default H Refresh || Save

> People Counting
> HeatMap

> Alarm
L
Storage

System
Information

Figure 5-84

Camera 8D Card Network

Network

Event Type S0 Card Error E
Video Deteclion [Z] Enable
Audio Detection [¥] Relay-out
Smart Plan Alarm Delay 10 | Second (10~300)
[C] Send Email

Face Detection
Default Refresh

People Counting

Heat Map

Alarm

Storage

System

Information

Figure 5-85




Network

Camera SD Card llegal Access

Network

Event Type Capacity Warning Iz]
» Video Detection [l Enable
> Audio Detection Capacity Limit 10 %(0~09)
> Smart Plan [¥] Relay-out
> IV Alarm Delay 10 Second (10~300)
» Face Deteclion [ Send Email

> People Counting

Default

> Heat W; H Refresh H Save
eat Map

> Alarm

Storage

System

Information

Figure 5-86

Please refer to the following sheet for detailed information.

Parameter | Function

Enable Check to alarm when SD card is abnormal.

Relay-out Check to enable relay-out alarm.

Relay out | The alarm output can delay for the specified time after alarm stops. The
delay value ranges from 10s to 300s.

Note:

No SD card, capacity warning, SD card error, relay-out delay all start
from alarm occurs.

Send After you enabled this function, the system can send out email to alarm
email the specified user.

This function is invalid when network is offline or IP conflict occurs.

SD Card User can set SD card capacity that is left free. When SD card space left
Capacity | is smaller than this limit, alarm occurs.
Limit

When device is offline or IP conflicts, the abnormal alarm is similar with case of SD card error.
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Network
Event Event Type Disconnection

ideo Detection [¥] Enable

Audio Detection 7] Record

rt Plan Record Delay 10 Second (10~300)
[] Relay-out
LR Alarm Delay 10 Second (10~300)
> People Counting
Default | | Refresh | | Save

> HeatMap

Storage
System
Information

Figure 5-87

When login password keep been wrong for a few times, unauthorized access alarm occurs. This
operation is similar to SD card error. Allow login error times as when it exceeds this limit, user account
will be locked.

lllegal Access

Camera SD Card

Network

[¥] Enable
» Video Detection Login Error 3 time (3~10)
» Audio Detection [¥] Relay-out
> Smart Plan Alarm Delay 10 Second (10~300)
> [7] Send Email
» Face Detection

Default ‘ | Refresh ‘ | Save

» People Counting
> Heat Map
> Alarm

Storage

System

Information

Figure 5-88

5.4 Storage Management

5.4.1 Schedule

Before schedule setup, user must set record mode is auto or manual.

Note:

If record mode in record control is off, then device will not snapshot according to schedule.
5.4.1.1 Record Schedule

Record schedule steps:

Step 1. Click on Record Schedule, see Figure 5-89.



Camera Record Schedule

Network General | Motion Alarm B
Event
0 2 4 6 3 10 12 14 16 18 20 22 24
Schedule
> Destination
> Record Control =z Setup
System ‘Wednesday
Information Thursday Selup
Saturday Setup
Holiday Setup
peraut || Reresn || saw

Step 2. From Monday to Sunday select record time, click on setup on the right, see Figure 5-90.
® Set period according to actual need. There are six periods available each day.
® By checking or unchecking, you can add or delete three types of record schedule: General, Motion,

and Alarm.
Note:
Period setup can be done by dragging in record schedule interface while not releasing left mouse.
Setup %]
Y ¥ sunday I Monday I Tuesday I Wednesday I Thursday [ Friday [ Saturday I Holiday
Feriod 1: 00 - 00 : 00 |-| 23 : 89 : 59 | [T General W Motion ¥ Alarm
Period 2: 00 : 00 : 00 |-| 23 : 59 : 59 | [T General I motion I Alarm
Period 3: 00 - 00 : 00 |-| 23 : 59 : 59 | [T General [T Mmaotion I Alarm
Feriod 4: 00 : 00 : 00 |-| 23 : 89 : 59 | [T General I Motion I Alarm
Period 5: 00 - 00 : 00 |-| 23 : 59 : 59 | [ General [T Maotion [ Alarm
Feriod &: 00 : 00 : 00 |-| 23 : 89 : 59 | [T General I Motion I Alarm
Save ‘ ‘ Cancel |
Figure 5-90

Step 3. Click on OK, return to record schedule interface. See Figure 5-91.
® Green color stands for the general record/snapshot.

® Yellow color stands for the motion detect record/snapshot.

® Red color stands for the alarm record/snapshot.
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Camera Snapshot Schedule Holiday Schedule

Network

General | Motion Alarm W

2 4 [} 8 10 12 14 16 1 20 22 24
I T T T T T T T T T T T T T T T T T T T T T T T T T T T

Event

=

O ———————————————— ]
> Destination
> Record Control T Setup
Information Thursday —
s | —————————— —
iy ——————————— .

Figure 5-91

Step 4. In record schedule interface, click on OK. System prompts it is successfully saved.

5.4.1.2 Snapshot Schedule
Snapshot setup as:
Step 1. Click on Snapshot Schedule tab, see Figure 5-92.

Camera Record Schedule

Network

Snapshot Schedule Holiday Schedule

General |l Motion Alarm W

Event

=)

2 4 6 8 10 12 14 16 18 20 22 24
T T T T T T T T A A A |

> Destination up
Tuesd

> Record Control C=te m Setwp

System Wednesday

Information Thursday m —_
Saturday e ————————————————— —
1 ———————————— —

Deiault

Refresh

Save

Step 2. From Monday to Sunday select snapshot time, click on setup on the right. See Figure 5-93.
® Set snapshot period according to actual need. There are six periods available each day.

Figure 5-92




By checking or unchecking, user can add or delete three types of snapshot schedule: General,
Motion and Alarm.
Note: Period setup can be done by dragging in snapshot schedule interface while not releasing left
mouse.

Setup %]
T A ¥ sunday T Monday I Tuesday [ Wednesday [ Thursday [ Friday [ Saturday [T Holiday
Period 1: 00 : 00 : 00 |-| 23 : 89 : A9 | [ ceneral W mMotion [ Alarm
Period 2; 00 - 00 : 00 |-| 23 : 59 : 59 | [ cGeneral I Motion [ Alarm
Period 3: 00 - 00 : 00 |-| 23 : 59 : 59 | I[” ceneral I~ Motion [~ Alarm
Period 4: 00 : 00 : 00 |-| 23 : 89 : A9 | [ ceneral I mMotion [ Alarm
Period 5: 00 - 00 : 00 |-| 23 : 59 : 59 | [ cGeneral I Motion [ Alarm
Period 6 00 - 00 : 00 |-| 23 : 59 : 59 | I[” ceneral I~ Motion [~ Alarm
Save | | Zancel |
Figure 5-93

Step 3. Click on OK, return to snapshot schedule interface. See Figure 5-94.
® Green color stands for the general record/snapshot.

® Yellow color stands for the motion detect record/snapshot.

® Red color stands for the alarm record/snapshot.

Camera Record Schedule

REREL General |l Motion Alarm W
Event
0 2 4 & 8 0 12 14 1.8 18 20 2 24
Schedule
> Destination
Tuesd
> Record Control ] Sohp
system Wednesday
Information isis)
e
Holiday Setup
peaut || Revesn || Save

Step 5. In snapshot interface, click on OK. System prompts it is successfully saved.



5.4.1.3 Holiday Schedule
Holiday schedule can set specific date as holiday.
Step 1. Click on Holiday Schedule tab, see Figure 5-95.

Camera Record Schedule

PEENELT [C] Record [T] Snapshot

Calendar

Sun Mon Tue Wed Thu Fri Sat

Event

Storage

» Destination 1 2 3 4 5 6
> Record Control 7 3 g 10/ (11 [12] |13
System
Information

Retesh || save

Figure 5-95

Step 2. Select date to set as holiday. The selected date will be highlighted in yellow.

Step 3. Check Record/Snapshot, click on Save. System prompts it is successfully saved.

Step 4. Check Record Schedule/Snapshot Schedule interface, click on setup next to Holiday, and refer
to setup of Monday to Sunday.

Step 5. Complete setup of holiday, then it records/snapshots according to date in holiday schedule.

5.4.2 Destination

5.4.2.1 Path

The destination interface is shown as in Figure 5-96.

Path can config record and snapshot storage path. There are three options: Local, FTP and NAS. You
can only select one mode. System can save according to the event types. It is corresponding to the
three modes (general/motion/alarm) in the Schedule interface. Please check the box to enable the save
functions.

Note: Only device supports SD card has local.



Camera Path

Network Record

Event

Snapshot

Event Type Scheduled Motion Detect Alarm Event Type Scheduled Motion Detect Alarm
Local Local
P SERIEILD FTP &) &} O FTP O 0 ]
NAS B B B NAS B B B
» Record Control
‘ Default H Refresh H Save
System
Information
Figure 5-96
Please refer to the following sheet for detailed information.
Parameter | Function
Event It includes: scheduled, motion detect and alarm.
Type
Local It saved in the SD card.
FTP It saved in the FTP server.
NAS It saved in NAS disk.
5.4.2.2 Local

The local interface is shown as in Figure 5-97.
Here you can view local Micro SD card or NAS disk information. You can also operate the read-only,
write-only, hot swap and format operation.

Camera
Network

ontrol

Information

Status Attribute
Disk1 MNormal Read & Write

Used Capacity/Total Capacity
— | 6297 TM7S78.1M

Read Only

‘ | Read & Write | ‘ Hot Swap ‘ | Refresh

Figure 5-97




5.4.2.3 FTP

The FTP interface is shown as in Figure 5-98.

You need to check the box to enable the FTP function. When network disconnect occurred or there is
malfunction. Emergency storage can save the record/snapshot picture to the local SD card. Click the
test button to check if the FTP server can be connected for test.

Camera Path

Enable
Server Address

Part |21 (0-65535)
User Name anonymity

Password |

Remote Directory | st_wg_re

Information Emergency (Local) o

[ peru || gewesn [ sae

Figure 5-98

5.4.2.4 NAS

You need to check the box to enable the NAS function. Select NAS storage, fill in NAS server
address and corresponding store path, then you can store video file or pictorial information in the NAS
server.

Select NAS storage as to same file to NAS disk. See Figure 5-99.

Camera Path

Notwor Enable

Event
Server Address

Remote Directory
> Schedule

> Record Control

System

Information

Figure 5-99

Parameter Function

Server Address | Set IP address of NAS server.




Parameter Function
Remote Set storage directory, videos and pictures can be stored in to corresponding server
Directory directory.

5.4.3 Record control
The record control interface is shown as in Figure 5-100.

Camera
Network
Event

Storage

> Schedule

Disk Full

> Destination

Record Control

System

Information

Record Control

Pack Duration

Pre-event Record

Record Mode

Record Stream

3 Minute (1~120)

5 Second (0~5)

Overwrite [~]
@ Auto @) Manual ) Off
Main Stream [+]
petaut || Reesn || saw

Figure 5-100
Please refer to the following sheet for detailed information.

Parameter | Function

Pack Here you can select file size within 1min~120min. Default setup is 8

Duration minutes.

Pre-record | Please input pre-record value here.
For example, system can record the four seconds video in the buffer.
The record begins from the fifth second.
Note:
Configure pre-record time, when alarm or motion detection occurs, if
there is no record, system will record the preceding n seconds
record.

Disk Full There are two options: stop recording or overwrite the previous files
when HDD is full.
® Stop: Current working HDD is overwriting or current HDD is full,

it will stop record.
® Overwrite: Current working HDD is full; it will overwrite the
previous file.

Record There are three modes: Auto/manual/close.

mode

Record There are two options: main stream and sub stream.

stream
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5.5 System

5.5.1 General
The General interface is shown as in Figure 5-101.

Date&Time

Camera General

Network

Device Name YZCADZ021W00009

Event
Language English E|
Storage

Video Standard PAL E|
TVOut Open El

Default ‘ | Refresh ‘ | Save

> P

> Default
> Import/Export

> Auto Maintain

> Upgrade

Information

Figure 5-101

Please refer to the following sheet for detailed information.

Parameter Function

It is to set device name.

Device o2 ; ,

Name Note: Different devices have different names.
Video This is to display video standard such as PAL.
Standard

Language You can select the language from the dropdown list.

TV Out You can open or close the function, it can only be supported by the
devices with TV Out.

® Intelligent function will be disabled when TV Out is opened.
® |t will auto close TV Out when intelligent function is enabled.
® Some devices support SDI and HDCVI.

The Date & Time interface is shown as in Figure 5-102.



Camera
Network
Event

Storage

> Account
> PTZ Settings
> Default
> Import/Export
> Auto Maintain

> Upgrade

Information

General

General
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Date&Time

Date Format Year-Month-Day [+]

Time Format 24-Hour-based System E

Time Zone GMT+08:00 [~]

Current Time 2000 - 05 - 22 |[ 19 . 37 . 19
[C] DST Enable

DST Type @ Date ) Week

Start Time Jan =] 1 [=]| o0 : o0 :

End Time Jan (=] 2 [=]| o0 - 00 -
[] Synchronize with NTP

NTP Server clock.isc.org

Port 123

Update Period 10 Minute (0~30)

petaut || Reesn || saw
Figure 5-102

Please refer to the following sheet for detailed information.

Parameter

Function

Date format

Here you can select date format from the dropdown list.

There are two options: 24-H and 12-H.

Time

Format

Time zone The time zone of the device.

Current It is to set system time. It becomes valid after you set.

Time

Sync PC You can click this button to save the system time as your PC current
time.

DST Enable | Here you can set both begin and end time of daylight saving time.

You can set according to the date format or the week format.

Synchronize

You can check the box to enable NTP function.

with NTP

NTP server | YOu can set the time server address.

Port It is to set the time server port.

Update It is to set the sync periods between the device and the time server.

period
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5.5.2 Account

® For user name and user group, the max length is 31 characters, which can be made up of digit,
letter, underline, hyphen, dot and @.

® Password can be 0~32 characters in number and letter only. User can modify other user’s
password.

® User and group can be manually added to 18 and 8 respectively.

® User management adopts group/user modes. The user name and the group name shall be unique.
One user shall be included in only one group.

® Currently logged in user cannot change his/her own right.

5.5.2.1 Username
In this interface you can enable anonymity login, add/remove user and modify user name. See Figure 5-
103.

Camera Account
Network

[C] Ancnymous Login

Event
User Name

Storage

No.

1 admin admin admin 's account 4 )

> General
Account
> PTZ Settings
> Default

> Import/Export
» Auto Maintain

> Upgrade —

Information Authority List
Live Playback Recerd Control Backup PTZ Account
Alarm Log Search Clear Log Upgrade Auto Maintain General
Video/Audio Schedule/Destination Network Abnomality Video Detect PTZ Settings
Default/import/Export Conditions S

Enable anonymity login: Enable anonymity login, and input IP. No username or password is required,
you can log in by anonymity (with limited rights). You can click logout to end your session.

Add user: Itis to add a name to group and set the user rights. See Figure 5-86.

Hidden user “default” is for system interior use only and cannot be deleted. When there is no login user,
hidden user “default” automatically login. You can set some rights such as monitor for this user so that
you can view some channel view without login.

Here you can input the user name and password and then select one group for current user.



Network Camera Web 3.0 Operation Manual

Please note the user rights shall not exceed the group right setup.
For convenient setup, please make sure the general user has the lower rights setup than the
admin.

Add User (|

UserMame
Fassword

Confirm Password

Group | admin j

Remark

Authority List ¥ Al
W Live i’
V¥ Playback

M Record contral

V¥ Backup &l

Save Cancel

Figure 5-104

Modify user

It is to modify the user property, belonging group, password and rights. See Figure 5-103.

Modify password

It is to modify the user password. You need to input the old password and then input the new password
twice to confirm the new setup. Please click the OK button to save.

Please note, the password ranges from 0-digit to 32-digit. It shall include the number and letter only. For
the user who has the account rights, he can modify the password of other users.
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Modify User [ X |
User Mame IEIjI'I'IiI'I j
™ Modify Password

Group |a:lmin j

Remark admin s account

Authority List ¥ Al
W Live il
M Playhack
¥ Record control
¥ Backup ~|

Save Cancel

Figure 5-105

5.5.2.2 Group
The group management interface can add/remove group, modify group password and etc.
The interface is shown as in Figure 5-106.

Camera Account

Hahv O [] Anonymous Login
Evem User Mame Group
ST Group Hame Remark Modify Delete
admin administrator group é -
2 user user group 4 —)
> PTZ
> Default
> ImportExport
> Auto Maintain
> Upgrade il
Information Autharity List
Live Playback Record Control Backup PTZ Account
Alarm Log Search Clear Log Upgrade Auto Maintain General
VideofAudio Schedule/Destination MNetwork Abnormality Video Detect PTZ Settings
DefaultimportExport Conditions Vs

Figure 5-106

Add group: Itis to add group and set its corresponding rights. See Figure 5-107.
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Please input the group name and then check the box to select the corresponding rights. It
includes: preview, playback, record control, PTZ control and etc.

Add Group [ X |
Group
Remark
Authority List Y
I Live i’
I" Playback
" Record contral
[ Backup =l
Save Cancel
Figure 5-107

Modify group
Click the modify group button, you can see an interface is shown as in Figure 5-108.
Here you can modify group information such as remarks and rights.

Modify Group | X
Group IEIZ|I'|'|iI'| =l
Remark administrator group
Authority List v Al
V' Live i’
¥ Playback

V¥ Record control

V¥ Backup &

Save Cancel

Figure 5-108

553 PTZ
Please note only some series products support this function.
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The PTZ settings interface is shown as in Figure 5-109.

Camera PTZ Settings
R Protocol PELCOD

Event

Address 1
Storage

Baudrate 9600

Data Bit 8
> General

> Account Stop Bit !

PTZ Settings

> Default

B G EE]

Parity None

> Impor/Export
> Auto Maintain

> Upgrade

Information

Figure 5-109

Please refer to the following sheet for detailed information.

Parameter | Function

Protocol Select the corresponding dome protocol.

Address Set corresponding dome address. Default value is 1.

Please note your setup here shall comply with your dome address;
otherwise you cannot control the speed dome.

Baud Select the dome baud rate. Default setup is 9600.

Rate

Data Bit Default setup is 8.

Stop bit Default setup is 1.

Parity Default setup is none.

5.5.4 Default
The default setup interface is shown as in Figure 5-110.
Please note system cannot restore some information such as network IP address, account and so on.
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Camera Default

Network

Event Seiat

Storage

> General
> Account
> PTZ Settings
> Import/Export
> Auto Maintain
> Upgrade

Information

Figure 5-110

5.5.5 Import/Export
The interface is shown as in Figure 5-109.

Camera Import/Export
(= Backup Path
Event

Storage inpcl | ‘ Epad

> General
> Account
> PTZ Settings
> Default

> Auto Maintain

> Upgrade

Information

Figure 5-111

Please refer to the following sheet for detailed information.

Parameter | Function
It is to import the local setup files to the system.

Import

Export It is to export the corresponding system setup to your local PC.

5.5.6 Remote control

Note:
It is supported by some devices.
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s 1B ] 541 T 2004 e

Camera Remote @
Network

Event Learn Remote = | Learn ‘ | Clear |
ArmiDisarm |Arm j |ms j

Storage

> General

> Account

> Default

> Import/Export
Hemoe.

> Auto Maintain
> Upgrade

Information

Figure 5-112
Parameter Function
Learn Bind remote control or wireless alarm with equipment.
Clear Unbind remote control with equipment.

Start arm after the time you choose, disarm comes into effect immediately. Note:

Arm/Disarm With disarm status, all the following alarms won’t trigger: motion detect alarm,
masking alarm, local alarm, PIR alarm, wireless alarm.

5.5.6 Auto Maintenance

The auto maintenance interface is shown as in Figure 5-113.

Here you can select auto reboot and auto delete old files interval from the dropdown list.
If you want to use the auto delete old files function, you need to set the file period.

Auto Maintain

Auto Reboot Tuesday

[[] Auto Delete Old Files

Manual Reboot

» General |

Refresh ‘ |

> Account

> PTZ Settings
> Default

> Import/Export
> Upgrade

Information

Figure 5-113
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Parameter Function

Auto Reboot Check it and set auto reboot time.

Auto Delete Old

Files Check it and set period within 1~31 days.

5.5.7 Upgrade
The upgrade interface is shown as in Figure 5-114.
Please select the upgrade file (file extension is “.bin”) and then click the update button to begin firmware

update.

Important
Improper upgrade program may result in device malfunction!

Camera

Network Select Firmware File

Event

Storage

> General
> Account
> PTZ Settings
> Default
> Import/Export
> Auto Maintain

Information

Figure 5-114

5.6 Information

5.6.1 Version

The version interface is shown as in Figure 5-115.

Here you can view system hardware features, software version, release date and etc. Please note the
following information is for reference only.

Camera Version

Network

Device Type IPC-HF 3300

Event
Software Version 2.420.0000.0.R, build - 2014-03-14

Storage

WEB Version 321175653
System

ONVIF Version 244

SIN PZC1EW24200002

Version

> Log

Copyright 2011,All Rights Reserved

> Online User

Figure 5-115
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5.6.2 Log
Here you can view system log. See Figure 5-116.

Camera
Network

Start Time | 2014 - 03 - 30 11 017 - 02 EndTime | 2014 - 03 - 31 1 17 02
rch

-

No. Log Time

Et Type |All
Storage
System

nformation
> Version

> Online User

Detailed Information

M1/l P MGoTo (=)

Figure 5-116
Please refer to the following sheet for log parameter information.
Parameter | Function
Start time Set the start time of the requested log. (The earliest time is 2000/1/1)
End time Set the end time of the requested log. (The latest time is 2037/12/31)
Type Log type.
Search You can select log type from the drop down list and then click search
button to view the list.
You can click the stop button to terminate current search operation.
Log You can select one item to view the detailed information.
information
Clear You can click this button to delete all displayed log files. Please note
system does not support clear by type.
Backup You can click this button to backup log files to current PC.

5.6.3 Online User

The online user interface is shown as in Figure 5-117.
Here you can view current online user, group name, IP address and login time.
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Camera Online User

Network

No. User Local Group IP Address User Login Time
Event 1 admin admin 10.18.116.47 2000-05-22 18:33:46
Storage
system

> Version
> Log

Figure 5-117



6 Alarm
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Please note some series product does not support this function.
Click alarm function, you can see an interface is shown as in Figure 6-1.
Here you can set device alarm type and alarm sound setup.

Alarm Type

[”] Motion Detection
[] DiskError

[] External Alarm
[”] Audio Detection

[] Scene Changing
Operation

[ Prompt
Alarm Tone

[] Play Alarm Tone

Tone Path

[”] DiskFull

[C] Video Tampering

[C] Megal Access

O ws

No.

Alarm Type

Alarm Channel

Figure 6-1

Please refer to the following sheet for detailed information.

Type

Parameter

Function

Alarm

type

Motion detection

System alarms when motion detection alarm
occurs,

Disk full System alarms when disk is full.

Disk Error System records alarm info when disk error
happens.

Video System alarms when video is tampering.

Tampering

External alarm Alarm input device sends out alarm.

lllegal Access System alarms when there is illegal access.

Audio Detection

System alarms when there is audio detect.

IVS

System alarms when IVS event is triggered.

Scene Changing

System will record alarm info when triggering
scene changing.
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Type Parameter Function

Operation | Prompt

A

When alarm is triggered, there will be s =/ |
inmain menu of alarm interface and system
automatically records alarm info. The icon
disappears when user click on alarm menu bar.
Note:

If alarm interface is displayed, when alarm is
triggered, there will be no image prompt, but alarm
record will be in list on the right.

Alarm Play Alarm Tone | Click it and select the path of audio file to be

Tone played in the tone path, when the subscribed alarm
event triggers, it will play the selected audio file to
prompt that there is alarm event which has been
triggered.

Tone Path You can customize the storage path of the alarm
tone.
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7 Log out

Click log out button, system goes back to log in interface. See Figure 7- 1.

Usemame: | admin

Figure 7- 1

Note:

® This manual is for reference only. Slight difference may be found in user interface.

® All the designs and software here are subject to change without prior written notice.

® All trademarks and registered trademarks mentioned are the properties of their respective
owners.

® [f thereis any uncertainty or controversy, please refer to the final explanation of us.
® Please visit our website for more information.





